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1

Basic tasks
This chapter includes the following topics:
■

Displaying HyperScale storage data

■

Monitoring HyperScale storage statistics using Grafana

■

Working with data nodes

■

Working with compute nodes

■

Displaying alerts so you can take corrective action

■

Configuring HyperScale to provide application-consistent snapshots

■

Configuring high availability for the HyperScale controller

Displaying HyperScale storage data
The HyperScale dashboard gives you an overview of important storage statistics.
Use the dashboard to monitor the overall health of your environment or identify
HyperScale events and alerts that need your attention. You can also use the
dashboard to focus on specific nodes, workloads (instances), or tenants.

Overall storage view
The Overall view is an aggregate display of storage under HyperScale management
in your cloud environment. The overall view does not focus on a specific node or
workflow.
This view is divided into four areas:
■

Compute plane statistics

■

Data plane statistics
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■

Tabs that display graphs for I/O per second (IOPS), throughput, and latency

■

An alerts area

Figure 1-1

Compute plane statistics

The Compute Plane area displays the following:
■

Persistent storage and cache usage; you can hover over the doughnut icons to
get more details data about used and free storage

■

Overall IOPS, throughput, and latency

Figure 1-2

Data plane statistics

The Data Plane area displays the following:
■

Persistent storage and cache usage; you can hover over the doughnut icons to
get more details data about used and free storage

■

The number of instance snapshots stored on the data plane, both the total
number (admin and user snapshots) and those taken by users alone

■

The number of virtual disks (vDisk) on the data plane

■

The number of backups that have occurred

■

The number of exports to the external storage provider
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Figure 1-3

The Alerts area

The Alerts area of theHyperScale dashboard displays information or errors that
you may need to take action on. Situations in which alerts are displayed include
the following:
■

Compute node or data node goes down.

■

SSD usage on the compute node exceeds 90%.

■

I/O errors occur on the compute node, including I/O errors on the vDisks.

■

HDD usage on the data node exceeds 90%.

See “HyperScale alerts reference” on page 95.

Primary storage view
The Primary storage view lets you focus on individual nodes in the compute plane.
Use the drop-down menu to select Primary. Start typing the name of a node in the
search box and click Show Summary. This view displays storage and performance
statistics for the specified compute node.
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Figure 1-4

Statistics for a specific compute node

In this view, the Alerts area, and the performance tabs at the bottom of the screen
only show information for the specified node.
See “HyperScale alerts reference” on page 95.

Secondary storage view
The Secondary storage view lets you focus on individual data nodes in the data
plane. Use the drop-down menu to select Secondary. Start typing the name of a
node in the search box and click Show Summary. This view displays the same
types of data plane statistics as the overall view, but only for the specified data
node.
Figure 1-5

Statistics for a specific data node

The Alerts area only shows information for the specified node.

Workload view
The Workload storage view lets you focus on instances running in your HyperScale
environment. Use the drop-down menu to select Workload. Start typing the name
of instance in the search box and click Show Summary. This view displays the
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same types of compute and data plane statistics as the overall view, but only for
the specified instance.
Figure 1-6

Statistics for a specified instance

In this view, the Alerts area, and the performance tabs at the bottom of the screen
only show information for the specified instance.

Tenants view
The Tenants storage view lets you focus on individual tenants running in your
HyperScale environment. Use the drop-down menu to select Workload. Start typing
the name of tenant in the search box and click Show Summary. This view displays
the same types of compute and data plane statistics as the overall view, but only
for the specified tenant.
Figure 1-7

Compute plane statistics for a specific tenant
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Figure 1-8

Data plane statistics for a specific tenant

In this view, the Alerts area, and the performance tabs at the bottom of the screen
only show information for the specified tenant.

Monitoring HyperScale storage statistics using
Grafana
You can monitor the storage statistics of your HyperScale environment using the
Grafana user interface (UI). An open source metric analytics and data visualization
tool, Grafana offers a richer user experience in data visualization and analytics with
its use of dashboard and panels that are dynamic and interactive. Refer to the
Grafana documentation for more details:
https://grafana.com/
HyperScale utilizes the collectd daemon for gathering system and application
performance metrics from the HyperScale environment. This information is then
stored as time series data in a InfluxDB database and the database then acts as
the data source for Grafana. The data from this database is displayed in a
consolidated manner within the HyperScale Grafana dashboard.

About the Grafana user interface setup
The Grafana setup is automatically created when you deploy HyperScale in the
OpenStack environment. You do not need to perform any additional configuration
steps.
The HyperScale installer installs the Grafana server, InfluxDB, and the collectd
deamon and configures all the components automatically.
HyperScale uses the Grafana HTTP API to add the data source and create a global
user by the name hyperscale with password as hyperscale. This hyperscale
user account is then used to access the Grafana dashboard.
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Accessing the HyperScale Grafana UI
After you complete the HyperScale installation, you can access the Grafana user
interface (UI) directly from the OpenStack Horizon dashboard.
To launch the HyperScale Grafana UI:

1

Launch a web browser and type the URL that you noted during the HyperScale
installation.
The URL format is as follows:
http://<ControllerNameorIP>/horizon

Here, <ControllerNameorIP> is the fully qualified domain name or public IP
address of the OpenStack controller node.

2

Specify the OpenStack admin user name and password on the login page and
click Connect.
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3

Navigate to HyperScale > Monitor and then click Click here to monitor
HyperScale statistics link that appears in the right pane.
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4

This launches the Grafana UI in a new browser window.
You can now navigate through the options displayed on the UI to view specific
information.

The Grafana UI is launched in the context of the hyperscale user account
over TCP port 3000. The hyperscale user is created at install time and the
password is set as hyperscale.
Note: The default Grafana user name is admin and the password is admin.

Viewing HyperScale storage data in the Grafana UI
The Grafana dashboard displays an overview of the key storage statistics in a single
consolidated perspective. You can use the information to monitor the overall health
of the HyperScale environment.
The information is spread across different display panels that are laid out in four
different rows and is broadly classified in the following categories:
■

IOPS Ratio
The top row displays the IOPS ratio (the input/output operations per second to
Gigabytes) that is currently being achieved by the storage provisioned in the
environment. The information is displayed in the form of a heatmap with the
IOPS ratio ranging from 0 (indicated in blue color) to 100 (indicated in red color).
The blue color means that the IOs served are either matching the application
demand or there are no IOs. The red color on the other hand indicates that the
IOs are falling short of the demand.
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■

Avg SSD Utilization

This panel displays the high performance Solid-state Drive (SSD) storage (Tier
0 storage) consumption rate. You will also see the count of the total SSD storage
available and currently in use listed separately right below the SSD utilization
display meter.
■

Avg HDD Utilization

This panel displays the high capacity hard disk drive (HDD) storage consumption
rate. You will also see the count of the total HDD storage available and currently
in use listed separately right below the HDD utilization display meter.
■

Avg IOPs Utilization
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This panel displays the IOPS utilization rate that is currently achieved by the
applications in the environment. You will also see the count of the maximum
IOPs capacity available and currently utilized listed separately right below the
IOPs utilization display meter.
■

Latency
This is the last panel in the second row on the UI and it shows the average
latency in milliseconds.

■

Graphical view
The last row in the Grafana UI displays a graphical chart representing the IOPs
and the latency. The IO data is separated based on read and writes.

Filters
HyperScale provides a set of default filters that you can use to segregate the storage
statistics further.
The following filter criteria are currently available:
■

Cloud
This filter is in effect by default. When you log on to the Grafana UI, all the
information that appears represents the storage data related to the entire
HyperScale environment.

■

Compute
Select one or more compute nodes from the Compute drop-down list to filter
the statistics based on the selected compute nodes. After you select a specific
compute node, you will notice that the information refreshes and the Avd SSD
and Avg HDD display meters reveal the storage capacity and consumption rates
for that compute node only.

■

Workload (instances)
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As the name suggests, use this filter to view storage statistics relevant to specific
workloads. Select one or more instances from the Workload drop-down list to
view storage information specific only to the selected instances.
You can filter the data by using each of these filter criteria in isolation or by combining
them. For example, you can select a specific compute node and then choose one
or more instances from the Workload filter to display a more specific set of data.
Note that the default value for these filters is ALL and that means that the Grafana
UI displays storage statistics for all the compute nodes and all the workloads running
in your HyperScale environment by default.

Working with data nodes
This section describes basic data node tasks.

Adding a data node
Adding a data node is the first task you perform after installing HyperScale. You
can add a data node from the HyperScale graphical user interface (GUI) or from
the command line.

About adding data nodes
HyperScale supports up to two data nodes. In the minimum production environment,
the first data node you add must be on the same node as the HyperScale controller.
In the preferred production environment, both data nodes are hosted on different
physical nodes.
Data nodes are used to store point in time snapshots of virtual machine volumes.
Every 15 minutes, the compute nodes write new data to the data plane. This
operation is known as Episodic Data Synchronization.
In addition, if there are two data nodes in the environment, for the VRTSSilver flavor
and above, one data node is the primary data node and the other is the secondary
data node. In this configuration, data is reflected from the primary data node to the
secondary data node. If one of the data nodes fail, all requests are served from the
other data node.
For virtual machines with the VRTSBronze flavor, there is no reflection at the data
node level. If the data node that is associated with a Bronze virtual machine fails,
you cannot access all the volume versions.

Before adding a data node
Check for the following:
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■

Ensure that you have installed HyperScale on the OpenStack controller

■

Make sure that the disks you intend to use for data node storage have the msdos
label type.

■

Keep the following information ready. You will need to specify these details while
adding a data node.
■

The management IP address of the Cinder node on which you are adding
the data node.
In the minimum production environment, this Cinder node is the controller
system.

■

The hyperscale sudo user account password

■

The OpenStack admin password.

Adding a data node from the HyperScale GUI
To add a data node from the graphic user interface

1

Launch a web browser and type the URL that you noted during the HyperScale
installation.
The URL format is as follows:
http://<ControllerNameorIP>/horizon/storage

Here, <ControllerNameorIP> is the fully qualified domain name or public IP
address of the OpenStack controller node.

2

Specify the OpenStack admin user name and password on the login page and
click Connect.

3

Navigate to HyperScale > System > Data Nodes.
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4

On the Data Nodes page, click Add Data Node.

5

On the Add Data Node panel, perform the following actions:
■

Provide the requested details as described in the following table:
Field name

Description

Management IP address Specify the IP address assigned to the management
network interface on the node that you want to add as
a data node.
Typically, the first data node is the same as the
controller node.

Note: Do not specify the public IP address of the
node.

■

Hypervisor user
Password

Specify the password of the hyperscale sudo user
account that you created before installing HyperScale.

OpenStack Password

Specify the OpenStack admin password.

Click Discover.
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HyperScale discovers the network interfaces and storage on the node.
■

From the Data plane interface drop-down list, select the network interface
associated with the HyperScale data network.
The drop-down list displays a network interface only if it is enabled and an
IP address is assigned to it.
Note: Do not select any other interface.

■

From the Backup gateway interface drop-down list, select the public
network interface of the data node.
This is used for backup and restore related communication between the
data node and the External Storage Provider or the backup proxy node.

■

Assign storage for the meta disk and data disks.
Select disks from the Available disks area and use the right arrow icons
to move them to the Meta disk area and Data disks area.
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At a minimum you need two disks—one for the meta disk and one for the
data disk. For better performance, choose a solid-state drive (SSD) for the
meta disks. If you specify multiple SSDs for the meta disks, HyperScale
automatically creates mirrored volumes on them. Mirrored metadata ensures
that even if one SSD fails, the data node continues to work and does not
have to switch to an alternate data node.
■

Click Add Data Node.
HyperScale begins to configure the data node. The dashboard displays
various messages that indicate the progress.
After the process is complete, the name of the data node that you just added
appears in the GUI under HyperScale > System > Data Nodes.
If there are any failures during the add node operation, refer to the log file
to troubleshoot the issues. To access the log file for a specific data node,
on the Data Nodes tab, under the Logs column, click the Download link
for that node.

Adding a data node using HyperScale commands
Perform the following steps on the controller node to add a data node using
HyperScale commands.
To add a data node from the command line

1

On the controller node, source the OpenStack RC file. This operation sets the
required environment variables.
# source keystonerc_admin

2

Add the data node using the dn-add command.
Use the following syntax:
# hyperscale dn-add [--data_disks <data_disks>]
[--meta_disk <meta_disk>] <datanode-mgmt-ip> <datanode-pwd>
<openstack-pwd> <dndata-itface> <data_cidr_range>
<dnpublic-itface> <public_cidr_range>

Here,
■

<datanode-mgmt-ip> is the IP address associated with the management
network interface on the data node

■

<datanode-pwd> is the password of the hyperscale sudo user account
that you created before installing HyperScale

■

<openstack-pwd> is the OpenStack admin password

■

<dndata-itface> is the name of the interface associated with the data network
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■

26

<dnpublic-itface> is the name of the public interface on the data node

Use commas to specify multiple disks.
Example:
# hyperscale dn-add --data_disks /dev/mapper/mpathb,/dev/mapper/mpathc
--meta_disk /dev/fioa
172.202.202.1 sudoroot123 openstackadmin123
eth5 172.202.202.0/24 ens4 <public IP range>

3

Monitor the add operation as it progresses.
Check the following log file on the controller node:
/var/opt/VRTSofcore/log/<datanode_mgmtip>_config.log

4

Verify that the data node was created. The nodes table has an entry for the
new data node and the data node's status appears as up.
The following abbreviated output shows the hostid of the new data node and
its status:
# hyperscale nodes
+----------------------------------------+
| hostid
|
+----------------------------------------+
{0001a036-9f33-3ea0-0000-000000000000}
|

...
...
...
...

+--------+
| status |
+--------+
| up
|

...
...
...
...

If an error occurs when you add a data node, information is written to the
/var/opt/VRTSofcore/log/<datanode_mgmtip>_config.log file on the controller
node.

Removing a data node
Before you remove a data node, make sure of the following:
■

HyperScale must be disabled on the compute nodes.
See “Disabling HyperScale on a compute node” on page 31.

■

You have the hyperscale sudo user account password and OpenStack admin
password of the data node you want to remove.

To remove a data node

1

Navigate to HyperScale > System > Data Nodes.

2

On the All Data Nodes table, locate the data node, and in the Actions column
click Remove Data Node.
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3

On the Remove Data node dialog box, enter the hyperscale sudo user account
password and the OpenStack admin password.

4

Click Remove Data node.

5

On the All Data Nodes page, the Status column is updated as the data node
is removed.

If any issues occur during this task, you can download the data node log from the
All Data Nodes page, or view the log on the following path:
/var/opt/VRTSofcore/log/<datanode_mgmtip>_config.log

Removing a data node that has computes enabled is possible only in the following
cases:
■

A network failure on the data node has triggered a datanode failover and that
has caused the vdisks to be evacuated to a peer data node

■

A permanent data node service failure where the service does not start even
after three restart attempts

■

If there is a storage failure

See “Data node resiliency” on page 78.

Working with compute nodes
This section describes basic compute node tasks.

Enabling HyperScale on a compute node
You can enable HyperScale on a compute node from the graphical user interface
(GUI) or from the command line.

Before you proceed
The following information is required to enable HyperScale on a compute node:
■

The hyperscale sudo user account password

■

The OpenStack password

About enabling HyperScale on compute nodes
The HyperScale compute node hosts the workloads. Although you can run all
services on a single compute node, you can add additional compute nodes to scale
out and expand your HyperScale cloud environment.
To make sure that the data on your compute nodes is resilient, you must enable
HyperScale on enough compute nodes to account for the reflection factor (the
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number of nodes to which the data is written) plus one. You need the additional
compute node in case one of the reflection targets goes down. The reflection factor
is based on the HyperScale flavor you assign to the virtual machines.
The following table shows the minimum number of compute nodes you need for
each virtual machine flavor.
Minimum number of compute nodes to provide resiliency

Table 1-1
Flavor

Reflection factor Compute nodes
(including the source compute node)

VRTSSilver 1

3

VRTSGold

4

2

If an error occurs when you enable HyperScale on a compute node, information is
written to the following log file on the controller node:
/var/opt/VRTSofcore/logs/<computenode_mgmtip>_config.log

Enabling HyperScale on a compute node using the GUI
To enable HyperScale from the GUI

1

Launch a web browser and type the HyperScale dashboard URL.
The URL format is as follows:
http://<ControllerNameorIP>/horizon/storage

Here, <ControllerNameorIP> is the fully qualified domain name or the public
IP address of the controller node.

2

Specify the OpenStack admin user name and password on the login page and
click Connect.

3

Navigate to HyperScale > System > Hypervisors.

4

In the All Hypervisors table, locate the hypervisor host on which you want to
enable HyperScale and on the right side of the table, under the Actions column,
click Enable HyperScale.

5

Perform the following actions on the Enable HyperScale panel:
■

Provide the requested details as described in the following table:
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Field name

Description

Hypervisor user
Password

Specify the password for the hyperscale sudo user
account that you created on the system before installing
HyperScale.

OpenStack Password Specify the OpenStack admin password.

■

Click Discover.

HyperScale discovers the storage for the specified hypervisor.
■

Assign disks for the Cache and Persistent storage.
Select disks from the Available disks area and use the right arrow icons
to move them to the Cache area and Persistent storage area.
At a minimum you need two disks—one for the cache and one for persistent
storage. For better performance, choose a solid-state drive (SSD) for the
cache.

■

Click Enable HyperScale.
HyperScale begins to enable HyperScale on the hypervisor. The dashboard
displays various messages that indicate the progress.
After the process is complete, the status under the HyperScale column
displays as Enabled/Running.
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If there are any failures during the operation, refer to the log file to
troubleshoot the issues. To access the log file for a specific hypervisor, on
the Hypervisors tab, under the Logs column, click the Download link for
that hypervisor.

Enabling HyperScale from the command line
Perform the following steps on the controller node to enable HyperScale on a
compute node using commands.
To enable HyperScale from the command line

1

On the controller node, source the OpenStack RC file to set the required
environment variables.
# source keystonerc_admin

2

Enable HyperScale on the hypervisor using the compute-enable command.
# hyperscale compute-enable [--data_intf <data-intf>]
<compute-ip> <compute-pwd> <openstack-pwd>
<compute-meta-disks> <compute-data-disks>

Here,
■

<data-intf> is the name of the interface associated with the data network

■

<compute-ip> is the IP address associated with the management network
interface

■

<compute-pwd> is the password of the hyperscale sudo user account that
you created before installing HyperScale

Use commas to specify multiple disks.
Example:
# hyperscale compute-enable --data_intf ens224
172.101.101.7 sudoroot123 openstackadmin@123
/dev/dbcomputestore/ssddisk3,/dev/dbcomputestore/ssddisk4
/dev/dbcomputestore/hdddisk3,/dev/dbcomputestore/hdddisk4

3

Monitor the operation as it progresses.
Check the following log file on the controller:
/var/opt/VRTSofcore/log/<computenode_mgmtIPaddress>_config.log

4

Verify that HyperScale was enabled on the compute node.
# hyperscale nodes
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If there are any failures during the operation, refer to the following log file on the
controller node to troubleshoot the issues:
/var/opt/VRTSofcore/log/<computenode_mgmtIPaddress>_config.log

Disabling HyperScale on a compute node
To complete this steps in the section, you need the following information:
■

The hypervisor password

■

The OpenStack password

To disable HyperScale in an OpenStack environment

1

Navigate to HyperScale > System > Hypervisors.

2

In the table, locate the hypervisor on which you want to disable HyperScale,
and on the right side of the table, click Disable HyperScale.

3

Complete the Disable HyperScale dialog box.
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4

Click Disable HyperScale.

5

Verify that HyperScale is disabled.
On the All Hypervisors page, the HyperScale column updates as HyperScale
is unconfigured. When the operation is completes, the column displays
Disabled.

Displaying alerts so you can take corrective action
The Alerts area of the HyperScale dashboard displays information or errors that
you may need to take action on. Situations in which an alert is displayed include
the following:
■

Solid-state drive (SSD) usage on the compute node exceeds 90%.

■

I/O errors occur on the compute node, including I/O errors on the vDisk.

■

Hard disk drive (HDD) usage on the data node exceeds 90%.

Alerts display information various parts of your HyperScale environment, including
compute nodes and data nodes, storage devices, instances, and vDisks.
See “HyperScale alerts reference” on page 95.
To display alerts
◆

Navigate to HyperScale > System > Overview.
An Alerts/Events table is displayed at the bottom of the page.

Configuring HyperScale to provide
application-consistent snapshots
Application-consistent backups are critical if your workloads contain databases or
database-backed applications. Unlike crash-consistent backups, an
application-consistent backup captures in-memory operations and pending I/Os by
quiescing an application and flushing all the pending operations to the disk. As the
snapshots are application aware, restoring data from application-consistent backups
does not require any additional steps.
You can configure HyperScale to provide application-consistent snapshots by
utilizing the QEMU Guest Agent. HyperScale integrates with QEMU Guest Agent
and makes it easy to take application-consistent snapshots in the OpenStack
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environment. After setting up the QEMU Guest Agent on the host and the guests,
all the instance (user) snapshots and backup snapshots taken thereafter are
application-consistent.
The QEMU Guest Agent daemon allows host machines to issue commands to the
guest operating systems using libvirt. The commands include operations that freeze
and thaw the filesystem within the guest in order to take snapshots. The
communication happens using a VirtIO serial connection between the host and
guest machines.
Refer to the RedHat documentation for more information on the QEMU Guest Agent.
The application-consistent snapshots can then either be exported to an External
Storage Provider from where they can be used to provision new instances or can
be made available to the backup software applications for backup and recovery
purposes.
The configuration process involves the following steps:
■

Adding the QEMU Guest Agent property to the Glance image metdata

■

Installing the QEMU Guest Agent in the guest operating system

■

Configuring the QEMU Guest Agent (Linux only)

■

Taking application-consistent snapshots

Adding the QEMU Guest Agent property
The first step is to add the QEMU Guest Agent property to the Glance image
metadata. This establishes a hardware communication channel (VirtIO) between
the host and the guest machines.
Perform these steps on the images before creating instances from those images.
To add the QEMU Guest Agent property to the image metadata

1

Log on to the OpenStack Horizon console as an administrative user and then
navigate to Project > Compute > Images.

2

In the Images pane, for a particular image, on the right hand side, click to
expand the Launch drop-down menu and select Update Metadata.

3

In the Update Image metadata dialog box, perform the following steps:
■

From the parameters displayed in the Available Metadata section on the
left, expand libvirt Driver Options for Images parameter and select QEMU
Guest Agent property and then click the plus sign to add it to the Existing
Metadata section on the right.
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Note that when you add the QEMU Guest Agent parameter, it appears as
hw_qemu_guest_agent in the Existing Metadata section on the right.

4

■

In the Existing Metadata section on the right, set the hw_qemu_guest_agent
parameter value to yes.

■

Click Save.

Repeat these steps for all images for which you wish to take
application-consistent snapshots.

34

Basic tasks
Configuring HyperScale to provide application-consistent snapshots

Installing the QEMU Guest Agent on the guest
The next step is to install the QEMU Guest Agent software component on the
operating system running inside the guest.
To install the QEMU Guest Agent on the guest

1

From the Images pane, for an image where you added the QEMU Guest Agent
property, click Launch to start the instance.

2

Confirm that the instance is active and running and then install the QEMU
Guest Agent on the guest operating system.
# yum install qemu-guest-agent

3

Start the QEMU Guest Agent service on the guest operating system.
# systemctl start qemu-guest-agent

Refer to the RedHat documentation for detailed instructions:
For Windows guests:
https://access.redhat.com/documentation/en-US/Red_Hat_Enterprise_Linux/6/
html/Virtualization_Administration_Guide/sect-QEMU_Guest_Agent-Running_
the_QEMU_guest_agent_on_a_Windows_guest.html
For Linux guests:
https://access.redhat.com/documentation/en-US/Red_Hat_Enterprise_Linux/7/
html/Virtualization_Deployment_and_Administration_Guide/chap-QEMU_Guest_Agent.html

Making configuration changes on Linux guests
This step is required only if applications such as Oracle and MySQL are installed
on instances that are running Linux operating systems. This is not required on
Windows guests.
For applications running on Windows instances, the QEMU Guest Agent works with
the Microsoft Volume Shadow Copy Service (VSS) framework that performs all the
tasks of pausing and resuming application I/O for taking snapshots.
For Linux instances, the QEMU Guest Agent uses an internal hook script
(/etc/qemu-ga/fsfreeze.hook), included with the qemu-guest-agent package by
default, to freeze and thaw the file system while taking snapshots. This ensures
that the snapshots are file system consistent. However, if you are running database
applications such as Oracle and MySQL on the Linux instances, the internal hook
script is not sufficient. You will have to create additional application-specific scripts
that can freeze and thaw database applications and also provide the status of those
commands.
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The QEMU Guest Agent provides a method to specify custom scripts that can be
invoked while taking snapshots. The agent daemon (qemu-ga) reads from a system
configuration file at startup and then processes the configuration options from the
command line. Application-specific scripts can be passed to the daemon as
command line arguments. The Guest Agent then invokes these scripts whenever
a snapshot job is triggered.
To be able to use custom scripts, modify the QEMU Guest Agent configuration as
follows:
■

■

Edit the QEMU Guest Agent configuration file located at
/etc/sysconfig/qemu-ga as follows:
■

Enable the fsfreeze-hook attribute (Set FSFREEZE_HOOK_ENABLE=1).

■

Set the log file path to /var/log/qemu-ga/qemu-ga.log.

Create the /etc/qemu-ga/fsfreeze-hook.d directory for your
application-specific scripts:
# mkdir -p /etc/qemu-ga/fsfreeze-hook.d

The QEMU Guest Agent automatically invokes the scripts from this directory
before freezing the file system.
This path is also used in the sample scripts provided.
■

Copy all the application-specific scripts to the /etc/qemu-ga/fsfreeze-hook.d
scripts directory that you created earlier.

Refer to the QEMU Guest Agent man page for more details about the qemu-ga
syntax and usage.
Refer to the RedHat documentation for details on how to use the QEMU Guest
agent:
https://access.redhat.com/documentation/en-US/Red_Hat_Enterprise_Linux/7/
html/Virtualization_Deployment_and_Administration_Guide/sect-Using_the_QEMU
_guest_virtual_machine_agent_protocol_CLI-libvirt_commands.html
Note: These steps and scripts are applicable for standalone applications such as
Oracle and do not apply to distributed applications.

Sample scripts
The following sample scripts are provided as a reference. You can use these scripts
to test the QEMU Guest Agent functionality and verify that the snapshots taken are
application-consistent.
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Oracle
Use this script to freeze and thaw the Oracle database.
Script name: foo.sh
#!/bin/bash
case "$1" in
freeze)
runuser -l oracle -c /etc/qemu-ga/fsfreeze-hook.d/frozen.sh >> /tmp/freeze
while [ "$(runuser -l oracle -c /etc/qemu-ga/fsfreeze-hook.d/status.sh |
grep QUIESCED)" -gt 0 ]; do
echo "Not yet QUIESCED.." >> /tmp/freeze
sleep 1
done;
echo "I am frozen!" >> /tmp/freeze
;;
thaw)
runuser -l oracle -c /etc/qemu-ga/fsfreeze-hook.d/thawed.sh >> /tmp/freeze
echo "I am thawed!" >> /tmp/freeze
;;
*)
exit 1
;;
esac

MySQL
Script name: frozen.sh
Use this script to freeze the database.
. ~/.bash_profile
sqlplus /nolog <<EOF
connect sysdba
as SYSDBA
@/etc/qemu-ga/fsfreeze-hook.d/frozen.sql
EOF

Script name: frozen.sql
This script is called internally from the frozen.sh script.
ALTER SYSTEM QUIESCE RESTRICTED;
select active_state from v$instance;

Script name: status.sh

Basic tasks
Configuring high availability for the HyperScale controller

Use this script to check the status of the database. This script is also called internally
from the foo.sh script.
. ~/.bash_profile
sqlplus /nolog <<EOF
connect sysdba
as SYSDBA
@/etc/qemu-ga/fsfreeze-hook.d/status.sql
EOF

Script name: status.sql
Use this script to take the status from the database.
select active_state from v$instance;

Script name: thawed.sh
Use this script to thaw the application.
. ~/.bash_profile
sqlplus /nolog <<EOF
connect sysdba
as SYSDBA
@/etc/qemu-ga/fsfreeze-hook.d/thawed.sql
EOF

Script name: thawed.sql
This script is called internally from the thawed.sh script.
ALTER SYSTEM UNQUIESCE;

Configuring high availability for the HyperScale
controller
When you deploy the HyperScale controller charm, it is automatically configured
in a state that is ready for high availability. HyperScale uses the virtual IP address
specified during the controller charm deployment, as the high availability end point
for the controller services.
HyperScale controller HA requires a minimum of three controller units. Configuring
high availability for the HyperScale controller therefore depends on how many
controller units are added while deploying the hyperscale-controller charm.
If you added multiple controller units during the initial charm deployment, then the
controller HA is already configured and in effect. However, if you added only a
single unit during the initial charm deployment, then the controller is not yet highly
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available. You will need to add additional controller units for the HA settings to take
effect.
Note: These steps are required irrespective of whether the charms were deployed
manually or using the automated installer script.
Perform the following steps on the Juju controller:
1.

Add a controller unit.
# juju add-unit hyperscale-controller --to lxd:<machineID>

Repeat the command for each additional unit that you wish to add.
2.

Modify the hacluster unit count parameter.
# juju config hacluster cluster_count=<num>

Here, <num> is the total number of controller units that are deployed in the
configuration.
For example, if you added two additional controller units later after the initial
controller charm deployment is complete, the total number of units will be 3.
(One unit created during charm deployment and two added later)
This step is important. Run this step each time there is a change in the number
of controller units in the HyperScale configuration.
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Protecting HyperScale
instances with an external
storage provider
This chapter includes the following topics:
■

Integrating an external storage provider with HyperScale

■

External storage provider requirements

■

Installing the external storage provider

■

Registering an external storage provider

■

Creating and exporting a snapshot

■

Exporting a copy of a snapshot

■

Launching an instance from an exported snapshot

■

Launching an export from a deleted instance

■

Export and import activity logs

■

Changing the level of detail in log files

■

Purging exports to free up space on the external storage provider server

■

Troubleshooting external storage provider issues

■

Unregistering an external storage provider

■

Uninstalling the external storage provider

■

External storage provider commands
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Integrating an external storage provider with
HyperScale
As a HyperScale infrastructure administrator, you may need to take regular
snapshots of critical instances (workloads). Taking regular snapshots helps prevent
the data loss that can occur from the following:
■

System failure

■

Data corruption due software issues

■

User errors

You also need to prepare for disaster recovery.
The HyperScale external storage provider is designed to meet these infrastructure
administrator needs. The external storage provider lets you create and export
HyperScale instance snapshots to an external storage device. The exported
snapshot can then be used to launch a new instance if the original becomes
corrupted, is accidentally deleted, or another data loss or disaster recovery situation
occurs.
You install this component on a separate system (node), also known as the external
storage provider node. It integrates with rest of the HyperScale components and
provides following features:
■

Create and export a snapshot
You can create new instance snapshots for instances running in your HyperScale
deployment and export these snapshots to the external storage provider node.
A temporary copy of the instance snapshot is created on primary/secondary
data node for the duration of export operation. Creating and exporting a snapshot
has almost no impact on I/O performance of the instance you export.
See “Creating and exporting a snapshot” on page 46.

■

Export a copy
You can copy a pre-existing instance snapshot and store it on the external
storage provider node. Exporting a copy has no performance impact on the
instance whose snapshot you export. After the export, pre-existing snapshot
remains unchanged on the secondary data node.
See “Exporting a copy of a snapshot” on page 47.

■

Launch an instance from an exported copy
You can launch a new instance from an export. You can launch the instance
from the same HyperScale deployment, or, in the case of a disaster recovery
situation, from a different HyperScale deployment.
See “Launching an instance from an exported snapshot” on page 48.
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To use the external storage provider features, you must have the infrastructure
administrator role in HyperScale. Depending on the configuration of the guest agent
inside an instance, the exported snapshots are either crash consistent, file system
consistent, or application consistent.
Making sure that data is securely and efficiently transferred between the HyperScale
nodes (compute and data nodes) and external storage provider requires some
advance planning.
See “External storage provider requirements” on page 42.

External storage provider requirements
HyperScale's external storage provider lets infrastructure administrators create and
export HyperScale instance snapshots to an external storage device. The exported
snapshot can then be used to launch a new instance if the original becomes
corrupted, is accidentally deleted, or another data loss or disaster recovery situation
occurs.
Making sure that data is securely and efficiently transferred between the HyperScale
nodes (compute and data nodes) and external storage provider requires some
advance planning.
■

You should connect the external storage provider to the same management
subnet and public network as the rest of the HyperScale deployment.

■

If the external storage provider is located in the same rack as the other
HyperScale nodes, connect its interfaces to the appropriate ports of the middle
of the rack switch.
Each of the subnets should have its own virtual LAN (VLAN).

■

The same holds true even if the external storage provider is located in a different
rack. However, the middle of the rack switches must be properly connected and
trunked to enable intra-VLAN traffic between the two racks.

■

Before you integrate an external storage provider with HyperScale, the provider
must be installed on a separate node that is not part of the HyperScale
environment.

The node must be a server-grade system with high I/O throughput. In addition, it
must meet the following requirements:
Table 2-1

Hardware requirements

Hardware

Requirement

RAM

32 GB minimum, 64 GB or higher recommended
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Table 2-1

Hardware requirements (continued)

Hardware

Requirement

Virtual CPUs

4 cores minimum, 8 cores recommended

Network speed

1 Gbps minimum, 10 Gbps recommended

Hardware type

Physical machine

Network interface cards 2 required
(NICs)
■ A 1 Gbps management NIC. Configure this NIC to be on
the same management subnet as the compute node and
data node.
■ A backup network NIC (10 Gbps or higher) to access the
node, check logs, and perform troubleshooting.
The backup network can either be on a separate subnet
of its own or can be configured to use the public NIC.
Physical storage

Enough physical storage to maintain instance snapshots.
HyperScale uses this space while performing restore
operations.
HyperScale maintains a full copy of instance vDisks and
metadata if it is exported to the external storage provider
node.
For example, if you export five instances that have a total of
5 TB of data written to their vDisks, the external storage
provider node requires 5 TB of storage.

Ports

Port 8334 is open or the firewall on the external storage
provider node is disabled.
Verify this before you try to register the external storage
provider from the HyperScale user interface.

Note: When the external storage provider imports or exports a snapshot, it
communicates with the primary and secondary data nodes using the management
subnet and the backup network. Therefore, the external storage provider node
should either be in the same physical rack as the HyperScale nodes, or, if it is
outside the rack, it should be able to communicate to other HyperScale nodes using
the management and backup networks.
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Figure 2-1

Controller node and data node communication with the external
storage provider node

Table 2-2

Software requirements

Software

Requirement

Operating system

Red Hat Enterprise Linux (RHEL) 7.2 Infrastructure Edition
(minimum)

Web framework

Flask 0.10.1 or later

Python

2.7 or later

Packages

The following packages are required on the External Storage
Provider node:
■

rpcbind

■

nfs-utils

Installing the external storage provider
To install the external storage provider

1

On the external storage provider node, install Python.
> yum install python

2

Use the Python easy_install module to install the Flask web framework.
> easy_install Flask

This command correctly sets the environment variables.
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Registering an external storage provider
Before you complete the steps in this section, do the following:
■

Have the fully qualified domain name (FQDN) of the external storage provider
server ready. See your export administrator for details. You can only register
one external storage provider with HyperScale.

■

Disable the firewall on the external storage provider node or open port 8334.

■

Data nodes should be enabled. The external storage provider host using the
data management IP address.

To register an external storage provider

1

Navigate to HyperScale > System > Backup/Export Providers.

2

On the Backup/Export Providers page, click Register Provider.

3

In the Register External Storage Provider dialog box, do the following:
■

Use the Type drop-down list to select HyperScaleESP.

■

In the Storage server field, enter the fully qualified domain name (FQDN)
of the external storage provider server.

■

Enter the storage server password and OpenStack password in their
respective fields.
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4

Click Register.
After the external storage provider is registered, it is listed on the
Backup/Export Providers page.

Creating and exporting a snapshot
As an infrastructure administrator, you can create new instance snapshots for
instances running in your HyperScale deployment and export these snapshots to
the external storage provider node. A temporary copy of the instance snapshot is
created on the primary/secondary data node for the duration of the export operation.
Creating and exporting a snapshot has almost no impact on the I/O performance
of the instance you export.
This is just one of the external storage provider features that can help you protect
your instances against:
■

System failure

■

Data corruption due to software issues

■

User errors
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The external storage provider can also aid you in disaster recovery.
To create and export a snapshot

1

Navigate to Admin > System > Instances.

2

In the Instances table, find the instance you want to create a snapshot for.
This example creates a snapshot for the instance VM1.
In the table row for that instance, use the Actions drop-down list to select
Create & Export Snapshot.

3

On the Create & Export Snapshot dialog box, specify the name of the new
snapshot.

4

Click Create & Export.
HyperScale displays the Tasks page, where you can monitor the progress of
the export.

Exporting a copy of a snapshot
You can export a copy of an instance snapshot that you have already created.
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To export a copy of a snapshot

1

Navigate to Admin > System > Images.

2

In the Images table, locate the snapshot that you want to export. In the Actions
column for that snapshot, select Export a copy from the drop-down list.

Launching an instance from an exported snapshot
You can launch a new instance from an instance snapshot that was previously
exported. This lets you put an instance into service quickly without specifying new
configuration values.
To launch an instance from an exported snapshot

1

Navigate to Admin > System > Instances.

2

On the Instances page, click the name of the instance whose snapshot you
want to launch. This example launches an exported snapshot of VM1.

3

On the Instances detail page, select the Versions tab.

4

Click on the export you want to use to launch a new instance.
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5

On the Launch VM from exported snapshot dialog box, in the Instance
name field, specify the name of the new instance to create. In this example,
the new instance name includes the date of the original snapshot.

6

Click Launch VM.
HyperScale displays the Tasks page, where you can monitor the instance
creation.

7

Return to the Instances page. When the instance is the running state, it is
ready to use.

8

To launch (import) the instance, navigate to Admin > System > Exports, find
the new instance, and click Import.

Launching an export from a deleted instance
You can launch an export from an instance that was previously deleted, either from
the graphical user interface or command line. This feature lets you return a version
of an instance to service that you had previously removed
To launch a deleted instance from the graphical user interface

1

Navigate to Admin > System > Exports, find the new instance, and click
Import.

2

On the Import Export dialog box, specify the name of the instance.

3

Click Import.
HyperScale displays the Tasks page, where you can monitor the instance
creation.
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To launch a deleted instance from the command line

1

List all the exports using following command line.
$ instancesnapshot-list-exports

2

Identify the export you want to use to launch a new instance. Take note of its
export ID.

3

Enter the following command and specify the export ID. If you need to restore
the instance to a different project than the one from which it was exported, also
specify the project ID.
$ instancesnapshot-launch-instance export_ID [project_ID]

Export and import activity logs
Each export job and import (launching an instance from an export) job triggered
through the Create & Export Snapshot and Export a Copy options on HyperScale
user interface or command line are logged in separate folders.
HyperScale logs each export or import operation initiation request in the
/var/opt/VRTSofesp/logs/hyperscale-esp.log file.
For example, an export job initiation request is logged in the hyperscale-esp.log
as follows. (The formatting in your file will look slightly different.)
Log file location [/var/opt/VRTSofesp/logs/
Export_ID/export.log]
for export [Export_ID]

In this case, detailed job logs are written to
/var/opt/VRTSofesp/logs/JobID/export.log.

Similarly, an import (launch instance) job initiation entry is logged in the
hyperscale-esp.log as follows. (The formatting in your file will look slightly
different.)
Log file location [/var/opt/VRTSofesp/logs/imports/JobID/export.log
for Import [Import_ID]

Detailed logs for this import job are written to
/var/opt/VRTSofesp/logs/imports/JobID/export.log.
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Changing the level of detail in log files
When you export snapshot data to an external storage provider, or when you launch
a virtual machine from exported data (an import operation), HyperScale writes data
to log files on the external storage provider node.
To access these log files, first go the file
/var/opt/VRTSofesp/logs/hyperscale-esp.log. This file includes the path to

each log file.
The log files are in the following formats:
■

/var/opt/VRTSofesp/logs/exports/JobID/export.log

■

/var/opt/VRTSofesp/logs/imports/JobID/restore.log

You can specify how much information is included in these log files.
To change the level of detail in log files

1

On the external storage node, stop the hyperscale-esp service.
> service hyperscale-esp stop

2

Navigate to the /opt/VRTSofesp/etc/esp-config file.

3

In this file, update the log-level parameter to one of the following:

4

lower

Provides basic operation information. It contains logs for all the error
conditions and information logs about the steps being executed, and success
or failure of each step in the flow of the program.

all

Provides detailed information about data transfer, token timeouts, and a large
amount of additional information logs that you may to diagnose issues. You
should only specify this log level when an issue occurs and you are not able
to diagnose it with the lower level log information.

Start the hyperscale-esp service.
> service hyperscale-esp start

Purging exports to free up space on the external
storage provider server
If space on the external storage provider server runs low, you can delete older
exports to free up space.
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Note: Exercise caution when you delete an export. After you delete it, you cannot
recover it.
To purge exports on the external storage provider server
◆

On the controller node, enter the following command.
# instancesnapshot-delete-export

Troubleshooting external storage provider issues
External storage provider error messages are written to the following log on the
external storage provider server:
var/opt/VRTSofesp/logs/hyperscale-esp.log

Logs for individual export or import (also known as launching an instance) jobs are
written to a separate log file each time.
/var/opt/VRTSofesp/logs/exports/JobID/export.log
/var/opt/VRTSofesp/logs/imports/JobID/import.log

Unregistering an external storage provider
The external storage provider can only be registered with HyperScale deployment.
You must unregister the current provider in the following circumstances:
■

You decide to change external storage providers.

■

You want to move the current external storage provider to another HyperScale
deployment.
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To unregister an external storage provider

1

Navigate to the HyperScale > System > Backup/Export Providers page.

2

On the Backup/Export Providers page, click Unregister.

3

On the Confirm Unregister Provider dialog box, enter the host password and
OpenStack password, and click Unregister.

You can now uninstall the external storage provider software.
See “Uninstalling the external storage provider” on page 53.

Uninstalling the external storage provider
Before you try to uninstall the external storage provider, make sure that you have
unregistered it.
See “Unregistering an external storage provider” on page 52.
To uninstall the external storage provider

1

Navigate to HyperScale > System > Backup/Export Providers.

2

On the Backup/Export Providers page, verify that the status of the external
storage provider is unregistered.

3

In the Actions column, click Clear.
Note: This operation does not have a confirmation screen. When you click
Clear, the external storage provider is immediately uninstalled.
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Even though the external storage provider software is uninstalled, the exported
snapshots remain on the external storage provider node.

External storage provider commands
In addition to the HyperScale user interface, you can enter a wide range external
storage provider commands from the controller node command line.
See “Vendor registration commands” on page 110.
See “Instance snapshot and restore from snapshot commands” on page 115.
See “Export and import commands” on page 116.
For a complete list of HyperScale commands, see the appendix.
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Protecting HyperScale
instances with NetBackup
This chapter includes the following topics:
■

About integrating NetBackup into your HyperScale environment

■

Setting up NetBackup

■

NetBackup integration requirements

■

Registering NetBackup with HyperScale

■

Configuring a default NetBackup policy for HyperScale

■

Creating backup policies in NetBackup for HyperScale workloads

■

Assigning a backup policy

■

Verifying the NetBackup integration

■

Restoring an instance from a backup

About integrating NetBackup into your HyperScale
environment
Integrating Veritas NetBackup into your Veritas HyperScale environment is a
collaboration between the HyperScale infrastructure administrator and the NetBackup
administrator. Steps must be performed on both the NetBackup Master/Media server
and on HyperScale. For example, before you can register NetBackup as a backup
provider with HyperScale, the NetBackup administrator must tell you the Media
Server fully qualified domain name and password, the OpenStack password, and
the directory on the Media Server (also known as the staging location) that

Protecting HyperScale instances with NetBackup
About integrating NetBackup into your HyperScale environment

temporarily stores the backups before they are ingested into the NetBackup storage
unit (STU) .
Similarly, before the NetBackup administrator can create HyperScale backup
policies, the HyperScale infrastructure administrator needs to tell the backup
administrator how often you want backups to occur for each type of backup policy
so that a staging location can be created with the required amount of free space.
The following table shows each backup task in order, and who performs it.
Table 3-1

HyperScale and NetBackup tasks

This task ...

Is performed by ...

Setting up the
NetBackup administrator
NetBackup environment
See “Setting up NetBackup” on page 57.
Meeting installation
requirements

NetBackup administrator

Registering NetBackup
with HyperScale

HyperScale infrastructure administrator

Configuring a default
NetBackup policy for
HyperScale

NetBackup administrator

See “NetBackup integration requirements” on page 58.

See “Registering NetBackup with HyperScale” on page 59.

See “Configuring a default NetBackup policy for HyperScale”
on page 61.

Creating a backup policy NetBackup administrator
See “Creating backup policies in NetBackup for HyperScale
workloads” on page 66.
Assigning a backup
policy to an instance or
flavor

HyperScale infrastructure administrator

Verifying NetBackup
integration

HyperScale infrastructure administrator and NetBackup
administrator

See “Assigning a backup policy” on page 66.

See “Verifying the NetBackup integration” on page 68.
Restoring from a backup HyperScale infrastructure administrator
See “Restoring an instance from a backup” on page 69.

This chapter describes that tasks of a HyperScale infrastructure administrator. It
mentions the general tasks the NetBackup administrator must perform, but the
specific steps are beyond the scope of this guide.
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For specific information about NetBackup, refer to Veritas NetBackup 8.0
Administrator's Guide:
https://www.veritas.com/support/en_US/article.000115725
You can also refer to the NetBackup software compatibility list:
https://www.veritas.com/support/en_US/article.000115691
Note: In this release, HyperScale is only qualified with NetBackup Version 8.

Setting up NetBackup
The NetBackup administrator must set up a dedicated Media Server in the production
environment. The Media Server is used as a backup proxy.
Table 3-2

NetBackup Media Server (backup proxy) requirements

Software / Hardware Requirement
RAM

32 GB minimum, 64 GB or higher recommended

Virtual CPUs

4 cores minimum, 8 cores recommended

Network speed

1 Gbps minimum, 10 Gbps recommended

Hardware type

Physical machine

Network interface cards 2 required
(NICs)
Physical storage

Enough physical storage to maintain instance snapshots.
HyperScale maintains a full copy of an instance's vDisks and
metadata when it is exported to the external storage provider node.
For example, if you export five instances that have a total of 5 TB
of data written to their vDisks, the external storage provider node
requires 5 TB of storage.

Network

Port 8334 is open or the firewall on the backup proxy node is
disabled.
Verify this before you try to register NetBackup from the
HyperScale user interface.

Packages

The following packages are required on the backup proxy node:
■

rpcbind

■

nfs-utils
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When the NetBackup administrator completes the configuration, HyperScale, the
NetBackup Media Server (backup proxy), and NetBackup Master Server should
have the following communication path.
Figure 3-1

Communications between the HyperScale controller and data
nodes and NetBackup Media and Master servers

In addition, the NetBackup administrator must configure the directory path that
HyperScale uses for restore operations; this is known as the staging location. This
location needs to be on a separate set of disks than that of the storage unit (STU)
disks (in case of a hard-disk backed STU).

NetBackup integration requirements
Note: This HyperScale release is only qualified with NetBackup Version 8.0.
To integrate NetBackup with HyperScale, the NetBackup administrator must verify
the following:
■

The NetBackup Media Server and Master Server must be installed. When you
install the servers, use the fully qualified domain names. Also use the fully
qualified domain name when you register the Media Server with the Master
Server.

■

The Media Server must be running Red Hat Enterprise Linux (RHEL) 7.2. The
"Minimal Install" is not supported; however, the RHEL software "Infrastructure
Server" and above are supported.
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■

The firewall on the backup proxy node is disabled, or port 8443 is open. (This
must be verified before you try to register NetBackup from the HyperScale user
interface.)

■

The date, time, and zone on the backup proxy node must be in sync with the
date, time, and zone on the Master Server. If the dates and times are not sync,
backups still occur, but they are not displayed on the HyperScale user interface.

After this information is verified, the NetBackup administrator must communicate
the following information to the HyperScale infrastructure administrator:
■

The Media Server fully qualified domain name.

■

The Media Server password.

■

The OpenStack password.

■

The staging location which is the directory path that HyperScale uses for restore
operations. This location needs to be on a separate set of disks than that of the
storage unit (STU) disks (in case of a hard-disk backed STU).

Registering NetBackup with HyperScale
The HyperScale infrastructure administrator performs this task. When you register
NetBackup with HyperScale, the external storage provider (ESP) package is installed
and configured on the NetBackup Media Server (also known as the backup proxy
server).
Before you proceed, make sure that the NetBackup administrator has given you
the following information:
■

The NetBackup Media Server (backup proxy) management IP address.

■

The path to the staging location on the NetBackup Media Server (backup proxy
server) that HyperScale uses for restore operations.

■

The public IP address of the backup proxy node.

The NetBackup administrator must also disable the firewall on the backup proxy
server node, or open port 8443.
You also need the OpenStack administrator password and the hyperscale sudo
user account password.
Before you register NetBackup, data nodes must be enabled.
Registering NetBackup with HyperScale

1

Navigate to HyperScale > System > Backup/Export Providers.

2

On the Backup/Export providers page, click Register.
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3

On the Register Provider dialog box, do the following:

■

In the Type field, use the drop-down list to select Veritas NetBackup.

■

In the Backup Proxy (Media server) Management IP field, specify the
management IP address of the backup proxy node.

■

Complete the rest of the fields using the information you gathered earlier
as per the prerequisites.

■

In the Backup Service IP field, specify the public IP address of the backup
proxy node.
All HyperScale backup related communication between the backup proxy
node and the HyperScale data node is carried over this public IP.

■

Check the Enable DR checkbox to enable a recovery mechanism for your
backup policy configuration.
This is useful in cases where your existing HyperScale setup (compute or
data node) has failed or the existing registered backup proxy node has
crashed and you want to be able to reconfigure the backup policies.
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After you create NetBackup backup policies for HyperScale workloads, the
backup policy configuration details can be restored to a new backup proxy
node or a different HyperScale setup altogether.
If this option is enabled, you do not need to recreate all the backup policies
and schedules. When your HyperScale setup is back online, you can restore
the backup policy configuration created earlier, from the NetBackup server.

4

Click Register. HyperScale displays the Backup/Export providers page,
where you can follow the progress of the installation.
Note: The ESP package is automatically installed on the Media Server. No
NetBackup administrator action is required.

5

When the registration completes, refresh the Backup/Export providers screen.
NetBackup is now listed.

Make a note of the staging location. This is required in the next step.

Configuring a default NetBackup policy for
HyperScale
Use the NetBackup Backup Policy Configuration Wizard to create a default backup
policy with a 24X7 calendar schedule. You must perform this step immediately after
you register NetBackup with HyperScale.
For detailed information on how to create a backup policy using the Backup Policy
Configuration Wizard, refer to the NetBackup documentation.
Before you proceed, ensure that you have the following details:
■

Backup proxy server management IP address

■

Staging location

You can get these details from the Horizon > Backup/Export providers screen.
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To create a default NetBackup policy for HyperScale

1

From the NetBackup Administration Console, expand NetBackup Management
> Policies and select Actions > New > New Policy.

2

On the Add a New Policy dialog box, specify a name for the HyperScale policy,
select the Use Policy Configuration Wizard checkbox, and click OK to start
the wizard.

3

On the Create a backup policy for screen, select File systems, databases,
applications and then click Next.

4

On the Policy Name and Type screen, confirm the policy name, and from the
Select the policy type drop-down list select Standard, and then click Next.
Ensure that you select the policy type as Standard.

5

6

On the Client List screen, click Add and then do the following on the Add Client
dialog box:
■

In the Client name space, provide the management IP address of the backup
proxy server.

■

From the Hardware and operating system drop-down list, select Linux,
RedHat2.6.18.

■

Click Add and then click OK.

On the Client List screen, verify that the backup proxy server management IP
appears in the client list and then click Next.
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7

On the Backup Selections screen, add the staging location directory path and
then click Next.

The staging location is the path on the backup proxy node that you noted earlier
after registering NetBackup with HyperScale. This is the path that HyperScale
uses for restore operations.

8

On the Backup Type screen, select Full Backup option and click Next.
Ensure that no other option is selected.

9

Follow the remaining wizard steps and complete the workflow with the default
values.

10 From the NetBackup Administration Console, launch the Policies Utility and
edit the backup policy you created earlier.

11 In the Change Policy screen, ensure that the following options are selected on
the Attributes tab:
■

Follow NFS

■

Cross mount points

■

Allow multiple data streams

63

Protecting HyperScale instances with NetBackup
Configuring a default NetBackup policy for HyperScale

12 In the Change Policy screen, on the Schedules tab, perform the following:
■

Click New to add a new calendar schedule and then on the Add Schedule
dialog box, specify a name for the schedule and select User Backup as
the Type of backup.
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■

On the Start Window tab, select a 24X7 time window.
For Start day:, select Sunday and specify Start Time: as 00:00:00.
For End day:, select Saturday and specify End Time: as 23:59:59.
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■

Click Add and then click OK.

13 Confirm that a new calendar schedule is added to the backup policy you created
and then click OK.

Creating backup policies in NetBackup for
HyperScale workloads
The NetBackup administrator performs this task. You should gather the following
information from the HyperScale user interface about the registered backup provider
and give it to them:
■

The fully qualified domain name used at the time of registration

■

Backup selection path (internally generated by HyperScale based on the staging
path you specified at the time of registration)

Assigning a backup policy
This task is performed by the HyperScale infrastructure administrator. The backup
policy defines when and how often an instance is backed up. You can assign a
policy to multiple instances or flavors at the same time.
To assign a backup policy to an instance

1

On the Backup Policies page, select the policy you want to apply. Under the
Actions drop-down list, select Assign/Update.

2

On the Assign/Update <name> policy to instances page, you have the
following options in the drop-down list:
■

Name

■

Status

■

Flavor

You can use a combination of these options to select your instances. For
example, you could select the name as VM. The regular expression is "contains"
rather than "equal to," so that all instances that contain the string VM are a
match.
You could filter the results further by specifying the flavor as VRTSBronze.
You can choose the flavors from the drop-down list.
The relationship between the two regular expressions is AND. The example
above lists instances whose name contains the string VM AND that also have
the VRTSBronze flavor.
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3

Click Run to list the instances that match your criteria.

4

Review the list of instances. If these are the instances to which you want to
assign the policy, click Assign Policy; otherwise, click Back to modify your
regular expressions.
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5

When the policy is assigned successfully, a confirmation screen is displayed.

Click Close.

6

Refresh the HyperScale > Backup Policies screen. A green colored indicator
against the policy name in the Name column confirms that the selected policy
is assigned successfully.

Now, when a backup is triggered from NetBackup, the instances that are associated
with the policy are backed up. Any instances that are created later that match the
regular expressions are also backed up.

Additional considerations
When you create the backup policy and instance assignments, these associations
are stored internally in the HyperScale configuration. However, in case of a
HyperScale reinstall or upgrade, this data is currently not retained.
If you reinstall or upgrade the HyperScale configuration after creating backup policies
and instance assignments, then the existing policy associations are lost permanently.
You must manually make a record of the backup policies and instance assignments
before you plan to reinstall or upgrade your HyperScale environment.

Verifying the NetBackup integration
This task is performed by the HyperScale infrastructure administrator. To verify that
NetBackup is successfully integrated with HyperScale, the NetBackup administrator
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triggers a manual backup. Both administrators can monitor the progress of the
backup on the respective user interfaces.
Note: Do not start a backup during a live migration. Wait until the live migration
completes.
To verify NetBackup integration on HyperScale
◆

Navigate to Project > Compute > Tasks page. You can see that backup has
been triggered. While the backup runs, the status is Creating. When the backup
finishes, the status is Completed.
Note: If a backup fails, it is not shown on the Backups tab. However, the Tasks
page shows that the backup is in the Failed state.

Restoring an instance from a backup
This task can be performed by both the HyperScale infrastructure administrator as
well as a HyperScale tenant/project user. Restoring a backup to a new instance
lets you quickly create a virtual machine from a previous point in time. This is
especially useful if an instance has failed and you need to get a version of it back
in service quickly.
The infrastructure administrator can restore from backup for any tenant. The backup
can be restored only to the tenant to which the virtual machine belonged at the time
of backups. Cross-tenant restores are not supported. You can restore an instance
from a backup using the backup list or the instance version time line.
A tenant user can only see and restore from backup images only for their own
tenancy.
To restore from a backup on the backup list

1

Navigate to Project > Compute > Backups.

2

In the list of backed up instances, locate the one that you want to restore, and
click Restore.
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3

On the Restore Backup dialog box, in the Instance name field, enter a new
instance name. This instance is created from the backed-up version.
Note: The new instance name cannot contain any spaces.

4

Click Restore. HyperScale takes you to the Project > Compute > Tasks page
so you can verify that the instance is being created. The instance is initially in
the Initiated state. It then moves the Creating state, and finally to the
Completed state.

To restore from a backup on the version time line

1

Navigate to Admin > System > Instances.

2

In the list of instances, click the name of the instance whose backup you want
to restore.

3

On the instance details page, Versions tab, select the backup you want to
restore from the time line. At the bottom of the time line is a light gray bar you
can use to horizontally scroll the time line to find your backup.

4

Click the icon for the backup you want to restore.

70

Protecting HyperScale instances with NetBackup
Restoring an instance from a backup

5

On the Restore from Backup dialog box, in the Instance name field, enter a
new instance name. This instance is created from the backed-up version.

6

Click Restore. HyperScale takes you to the Project > Compute > Tasks page
so you can verify that the instance is being created. The instance is initially in
the Initiated state. It then moves the Creating state, and finally to the
Completed state.
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Ensuring predictable
performance
This chapter includes the following topics:
■

Changing the miniops and maxiops QoS parameters from the command line

■

Changing the Tier 0 storage latency QoS parameter from the command line

Changing the miniops and maxiops QoS
parameters from the command line
HyperScale ensures that your virtual machines perform at a consistent quality of
service (QoS). Two parameters (miniops and maxiops) define the minimum and
maximum number of I/Os per second (IOPS) for the vDisk. To define the QoS for
your virtual machine, you can do one of the following:
■

Assign it a HyperScale flavor, which includes minimum and maximum IOPS
values.

■

Set (or change) the miniops and maxiops values from the command line using
the hyperscale qos-sla-update command.

This section describes the second approach.
The format of the hyperscale qos-sla-update command is:
hyperscale qos-sla-update [--miniops min_iops] \
[--maxiops max_iops] vdisk_id

To change the quality of service parameters from the command line

1

Obtain the ID of the vDisk whose QoS you want to change.

Ensuring predictable performance
Changing the Tier 0 storage latency QoS parameter from the command line

2

■

Navigate to Project > Compute > Volumes.

■

In the Volumes table, click the instance name.

■

On the Volumes details page, on the Overview tab, note the ID. That is
the vDisk ID to use.

Run the hyperscale qos-sla-update to modify one or both of the QoS
parameters. For example, the following command sets the minimum IOPS for
the vDisk to 100.
# hyperscale qos-sla-update --miniops 100 \
01310622-28a9-4fa1-bcb7-9c3d4dea8765

The following command sets the maximum IOPS to 1000.
# hyperscale qos-sla-update --maxiops 1000 \
01310622-28a9-4fa1-bcb7-9c3d4dea8765

Changing the Tier 0 storage latency QoS
parameter from the command line
HyperScale provides the hyperscale qos-config-update command to modify
the Tier 0 storage (SSD storage) latency value in order to achieve the desired
storage performance levels at the compute plane. This command sets the value
for the qos_config_ssd parameter that defines the worst case latency associated
with the Tier 0 storage layer.
A higher latency value can ensure higher IOPS from the compute node but does
not guarantee a high QoS miniops. A lower latency value guarantees high QoS
miniops but provides lower overall IOPS.
To modify the Tier 0 storage latency, run the following command on the HyperScale
controller or data node:
# hyperscale qos-config-update --hostname <computenodename> \
--latency <latencyinmicroseconds>

Here,
■

<computenodename> is the Fully Qualified Host Name (FQHN) of the compute
node for which the QoS configuration is to be updated.
This parameter is optional. If not specified, the command applies to all the
compute nodes in the HyperScale configuration.
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■

<latencyinmicroseconds> is the worst case latency for Tier 0 storage (SSD
storage) and is defined in microseconds. This parameter can take a minimum
value of 1000 microseconds and a maximum value of 10,000 microseconds.

This command updates the in-memory latency value as well as the value that is
stored in the QoS configuration file. The updated value takes effect immediately.
When you run this command the command output confirms whether or not the
command was successful. For example, when you run the following command to
change the latency to 1500 microseconds:
# hyperscale qos-config-update --latency 1500

The following output confirms that the command was successful:
+----------+---------------------------------------------------+
| Property | Value
|
+----------+---------------------------------------------------+
| response | Specified qos configuration updated successfully. |
+----------+---------------------------------------------------+

In cases where the command fails for some reason, the output confirms the failure
and also displays the reason for the failure.
For example, when you run the following command to change the latency to 1500
on a non-existent compute node named computenodea.bc.xyz.com:
# hyperscale qos-config-update --hostname computenodea.bc.xyz.com
--latency 1500

The following output confirms that the command failed due to an invalid host name:
+----------+---------------------------+
| Property | Value
|
+----------+---------------------------+
| response | Invalid hostname provided |
+----------+---------------------------+
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Compute node and data
node resiliency
This chapter includes the following topics:
■

Compute node resiliency

■

Data node resiliency

Compute node resiliency
In the compute plane, HyperScale provides resiliency for the following types of
failures:
■

Storage service failure

■

Reduced reflection factor

■

Storage media failure

If any of these failures occur, an alert is displayed in the Alerts/Events area of the
HyperScale dashboard (HyperScale > System > Overview).
For known issues related to HyperScale compute node resiliency, see "Compute
node issues" in the HyperScale Release Notes.

Storage service failure
If the HyperScale compute daemon (hscd) fails on a compute node that hosts virtual
machines, HyperScale automatically provides storage resiliency for those virtual
machines. No administrator action is needed.
The applications running inside the virtual machines do not encounter any timeouts
or errors, and HyperScale recovers the storage. This ensures that there is no
downtime for the virtual machines and applications.
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Reduced reflection factor
HyperScale maintains data resiliency on the compute nodes through a method
called reflection. When I/O occurs on a virtual machine, it is not only written on the
source compute node, but is also written (or reflected) to at least one other compute
node in the deployment. These additional compute nodes are called reflection
targets, and the number of reflection targets used is the reflection factor.
A virtual machine's reflection factor, depends on which HyperScale flavor you assign
to it. To use reflection, a virtual machine must have one of the following flavors.
HyperScale flavors and reflection factors

Table 5-1
Flavor

Reflection factor

VRTSSilver

1
Data is written to one reflection target.

VRTSGold

2
Data is written to two reflection targets.

If storage on a reflection target fails, HyperScale provides resiliency to restore the
reflection target. It automatically tries to restore the reflection factor by creating a
reflection copy on another compute node. You can check the restoration process
by entering the following command:
# hyperscale reflection-restore-status instance_uuid

instance_uuid is the OpenStack instance ID. You can find the instance ID by doing
the following:
1.

Navigate to Admin > System > Instances.

2.

Click on the instance you are interested in.

3.

On the Instances details page, noting the string in the ID row.

Resiliency is supported for following types of storage failures on the reflection target
node:
■

Storage service
If the storage service fails on the reflection target of a virtual machine, restoration
occurs on another available compute node. If another compute node is not
available, HyperScale retries on the same compute node by recovering the
compute storage service.

■

Media failure
If a solid-state drive (SSD) or hard disk drive (HDD) fails on a reflection target,
restoration occurs on an available compute node.
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In some cases, you must manually restore the reflection factor when a functioning
compute node is available. These situations include the following:
■

When you restart a crashed storage agent

■

When you add a new compute node

To manually restore reflection, enter the following command:
# hyperscale reflection-restore instance_uuid

Storage media failure
If an solid-state drive (SSD) or a hard disk drive (HDD) fails on a compute node
that hosts virtual machines, HyperScale provides resiliency of storage for the virtual
machines on that compute node. No administrator action is needed. The applications
running inside the virtual machines do not encounter any timeouts or errors.
HyperScale serves IOs from the reflection compute nodes.
Later, you can perform a live migration of the virtual machines from the compute
node that has the media failure. This ensures that there is no downtime for the
virtual machines and applications.

Reactivating SSDs on a compute node
Perform the following steps to enable the SSD storage on the compute node where
there was a storage failure.
To reactivate the SSD storage

1

Enable the SSD storage path.
# vxdmpadm enable path=nvme0n1

2

Stop the HyperScale storage service.
# sudo systemctl stop hyperscale-mq-storage

3

Unmount the HyperScale SSD mount path.
# umount /HyperScale-ssd

4

Deport the HyperScale SSD disk group.
# vxdg deport hyperscale-ssd-dg

5

Import the HyperScale SSD disk group.
# vxdg import hyperscale-ssd-dg

6

Restart teh HyperScale storage service.
# sudo systemctl start hyperscale-mq-storage
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7

Reactivate the SSD on the compute node.
# hyperscale reactivate-ssd [management-IP]

Here, [management-IP] is the IP address associated with the management
network on the compute node.

8

Disable the compute and then enable it again.
This refreshes the database and clears the alerts that were raised due to the
SSD failure.

Data node resiliency
The HyperScale data node acts as a secondary storage tier for storing vDisk
versions. vDisk versions are periodically synchronized with the data node. If a
compute node fails, the vDisk version is read from the data node. For a vDisk having
the VRTSSilver flavor and above, data is reflected from one data node (primary)
to another data node (secondary).
HyperScale provides resiliency at data plane in case of following data node failures.
There is minimal impact on applications and data management services such as
snapshots and recoveries. Alerts are raised for all these failures in the Alerts/Events
area of the HyperScale dashboard (HyperScale > System > Overview).
■

Storage media failure
If a data node's solid-state drive (SSD) or hard disk drive (HDD) fails, ongoing
snapshots are aborted, and the data node goes into the Down state. You must
remove the data node from the configuration. After you replace the faulty disk,
re-add the same data node in the configuration.
See “Removing a data node” on page 26.
See “Adding a data node” on page 21.

■

Data network failure
If the data node's data network card or data network cable fails, the data node
cannot communicate with the controller. The data node goes into the Down
state. After you fix the network communication issue, remove the data node
from the configuration and add it again.

■

Storage service failure
If the storage service (hyperscale-dmld) fails, the data node goes into the
Down state. You can remove failed data node and add a new one or fix the
existing node and add it again.

■

If the compute node cannot send episodic data synchronization messages to
the primary data node.
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In each of these failures, the vDisks associated with the failed data node are marked
as resiliency degraded and its ownership is transferred automatically to a peer data
node. The peer data node starts serving the next snapshots and recovery reads.
Any ongoing requests at the time of failure restart on the new primary data node
after the ownership change.
To restore the reflection back for degraded vDisks, you must remove the failed data
node, replace it, and perform a data node synchronization.
For more information, see the section synchronizing a data node.
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Configuring multi-rack
resiliency
This chapter includes the following topics:
■

About HyperScale support for multi-rack deployments

■

How HyperScale provides multi-rack resiliency

■

How to configure HyperScale for multi-rack resiliency

■

Administering rack information in a HyperScale configuration

■

Multi-rack command logs

About HyperScale support for multi-rack
deployments
When thinking about private cloud deployments using OpenStack, there are multiple
parameters that need consideration before the actual provisioning activity begins.
Increasingly demanding nature of workloads not only require scaling in terms of
processing power, memory, and storage, but adding resiliency capabilities so that
the configuration is able to withstand planned and unplanned downtime becomes
equally important.
One of the methods to tackle software and hardware failures is to physically
segregate server deployment using multiple racks. For example, you can deploy
the Controller on a separate rack and spread the compute nodes across two or
more racks. These racks can be placed adjacent to each other in a single area or
across multiple sites.
In case of a failure such as an instance failure, a compute or data node failure, or
a hardware malfunction resulting in a complete rack failure, the alternate racks
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provide active redundancy and are ready to handle the additional workloads, until
the failure condition is resolved and the failed setup is brought back online. The
intent of such a design is to provide resiliency and prevent having single points of
failure in the configuration.
HyperScale supports such multi-rack OpenStack deployments wherein compute
and data nodes are spread across two or more racks with the Controller node
residing on a separate rack or on one of the compute node racks.

How HyperScale provides multi-rack resiliency
HyperScale provides a set of commands that you can use to associate compute
nodes with the racks on which the nodes are deployed. This association is referred
as “tagging". When all the computes in a HyperScale configuration are tagged with
their respective rack information, the configuration is considered as enabled for
rack resiliency. HyperScale uses this rack resiliency status while determining where
to create reflection targets for eligible instances (Silver and Gold flavors) running
on the computes on each rack.
To achieve data resiliency for Gold and Silver instances running on compute nodes,
each instance I/O is written to the source compute node (that is the node that hosts
the instance) and at least one other additional compute node. This process is called
as reflection and the additional compute node is called as a reflection target. The
reflection target is another compute node on the same rack as the source node or
a compute node deployed on a separate rack altogether. HyperScale chooses
reflection targets based on the overall workload distribution and compute node
capacity.
In case of a rack resilient configuration, the reflection targets for all eligible instances
always reside on a different rack. HyperScale picks a target compute node from an
alternate rack and ensures that it is not on the same rack as where the source
compute node is deployed. Data resiliency is thus achieved using a "rack-resilient"
configuration that spans across multiple racks and is better prepared to deal with
single points of failure.
HyperScale treats a configuration as enabled for rack resiliency only if all the
computes within the configuration are tagged. Rack resiliency is not determined at
a rack level. If one compute on a rack is not associated with its respective rack
information, the configuration is not considered as rack-resilient, even if all the
computes on another rack are tagged.
Figure 6-1 shows a typical HyperScale multi-rack deployment consisting of two
racks—Rack-A and Rack-B, each hosting four compute nodes and one data node.
The Controller node resides on Rack-A, however it can also reside on Rack-B or
any other additional rack, as long it is on the same subnet.
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Figure 6-1

Typical multi-rack configuration
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Compute nodes C1, C2, C3, and C4 are tagged with Rack-A while C5, C6, C7, and
C8 are tagged with Rack-B. As all the computes are tagged with their respective
rack information, all the instances created in this configuration are rack-resilient.
If a silver instance is created on compute node C1, HyperScale creates a reflection
target on any of the compute nodes on Rack-B. For a Gold instance on C2,
HyperScale creates two reflection targets on two separate compute nodes, with at
least one of the target compute node residing on Rack-B. Similarly, any eligible
instances on the compute nodes on Rack-B have at least one reflection target
designated on Rack-A.
In a deployment with only a few compute nodes configured, HyperScale ignores
the flavor settings and creates only that many reflection targets as the number of
available and eligible compute nodes. For example, if there is only one compute
node in each rack, then for a Gold instance, even though the reflection factor is two
(which means data needs to be reflected to at least two additional compute nodes),
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HyperScale creates only one reflection target, either on the same rack or a different
rack, depending on the rack resiliency status of the configuration.

How to configure HyperScale for multi-rack
resiliency
Configuring HyperScale for multi-rack resiliency involves the following tasks:
1.

Adding rack information to the configuration

2.

Associating (or tagging) compute nodes with the respective racks

Prerequisites for configuring rack resiliency
The following details are required while configuring multi-rack resiliency:
■

Rack names

■

Rack descriptions

■

Site names

■

Controller node IP address

■

Controller node admin user name and password

Note: A minimum of two racks are required for rack resiliency to take effect in a
HyperScale multi-rack configuration. All the racks that are part of the multi-rack
configuration must belong to the same subnet.
Figure 6-2 shows the steps required to configure HyperScale for multi-rack resiliency.
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Figure 6-2
STEP 1

STEP 2

ControllerAdmin
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Multi-rack resiliency configuration steps
BEFORE YOU BEGIN
Keep the following details at hand:
Rack names, Rack descriptions
Site names
Controller IP address and admin user credentials

CONNECT TO THE CONTROLLER NODE
1. Connect to the Controller node using admin credentials:
# ssh <Controlleradminuser>@<ControllerIPaddress>
2. Set the default environment for authentication:
# source keystonerc_admin

STEP 3

ADD RACK DETAILS
Add rack details to the configuration, one rack at a time:
# hyperscale rack-add <rackname> --site_name <sitename> --desc <rackdescription>
<rackname> is mandatory. Use quotes if input parameter values contains spaces.
STEP 4

x-y-z

a-b-c

VIEW RACK IDs
Make a note of the unique rack ID assigned to each rack:
# hyperscale rack-list
Refer to the entries in the [rack_id] column.

STEP 5
x-y-z
a-b-c

TAG COMPUTE NODES WITH RACKS
Associate each compute node with its respective rack, one node at a time:
# hyperscale node-tag-rack <computenodenameorIPaddress> <rack_id>

STEP 6

VERIFY HYPERSCALE CONFIGURATION
Check that the rack details are accurately updated:
# hyperscale nodes
Refer to the entries in the [personality] and [rack_id] columns.

Once the rack information is updated in the HyperScale configuration, instances
(virtual machines) that are created thereafter are automatically treated as rack
resilient. While determining reflection targets for rack-resilient instances, HyperScale
uses the rack information to choose appropriate compute nodes from alternate
racks.
See “How HyperScale provides multi-rack resiliency” on page 81.
See “Administering rack information in a HyperScale configuration” on page 85.
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Administering rack information in a HyperScale
configuration
Use the commands described in this section to perform administrative tasks on
your multi-rack HyperScale configuration. Each command is described along with
the syntax and usage, followed by an example.

Add rack information to the HyperScale configuration
Run the following command on the HyperScale Controller node:
# hyperscale rack-add <rack_name> --site_name <sitename> \
--desc <rackdescription>

Here, <rack_name> is mandatory. The other parameters are optional. Use quotes
if the parameter input values contain empty spaces.
To view inline help about the command, type the following:
# hyperscale help rack-add

Example 1
Add a rack named “Rack-Alpha” belonging to a site named “Site-Charlie” and put
the description as “Primary-rack-Alpha”:
# hyperscale rack-add Rack-Alpha --site_name Site-Charlie \
--desc Primary-rack-Alpha

Example 2
Add a rack named “Rack Alpha” belonging to a site named “Site Charlie” and put
the description as “Primary rack: Alpha”:
# hyperscale rack-add "Rack Alpha" --site_name "Site Charlie" \
--desc "Primary rack: Alpha"

Delete rack information from the HyperScale configuration
Run the following command on the HyperScale Controller node:
# hyperscale rack-remove <rack_id>

Here, rack_id is a unique identifier key that HyperScale assigns to a rack to identify
it in the configuration. A random but unique identifier key is automatically allotted
as soon as a rack is added to the configuration and represents the rack as long as
it remains in the HyperScale configuration.

85

Configuring multi-rack resiliency
Administering rack information in a HyperScale configuration

When you remove a rack from the configuration, the unique identifier associated
with it gets purged and is never used again. Even if the rack associated with the
identifier is removed and added back in to the configuration, the earlier key is never
used again.
Note: You cannot delete rack details from the configuration if there is at least one
compute node associated with the rack.
To view inline help about the command, type the following:
# hyperscale help rack-remove

Example
Remove rack with rack id “53a354f3-9af8-410e-88d0-3332f3c15191”:
# hyperscale rack-remove 53a354f3-9af8-410e-88d0-3332f3c15191

Update rack information in the HyperScale configuration
Run the following command on the HyperScale Controller node:
# hyperscale rack-update rack_id --rack_name <rackname> \
--site_name <sitename> --desc <rackdescription>

Here, rack_id is mandatory. You cannot modify any rack information without
specifying the rack identifier in the command.
This command modifies details of the rack that is added to the HyperScale
configuration. You can modify the rack name, the site name, and the description,
in any order, in a single command. You can also modify each of these parameters
individually using a separate command.
To view inline help about the command, type the following:
# hyperscale help rack-update

Example 1
Modify name of rack with rack id “53a354f3-9af8-410e-88d0-3332f3c15191” to
“Rack-Beta”, assign it to site “Site-Tango”, and put the description as
“Secondary-rack-Beta”:
# hyperscale rack-update 53a354f3-9af8-410e-88d0-3332f3c15191 \
--rack_name Rack-Beta \
--site_name Site-Tango \
--desc Secondary-rack-Beta
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The same result can also be achieved using the following command (note that the
order of the parameters is reversed):
# hyperscale rack-update 53a354f3-9af8-410e-88d0-3332f3c15191 \
--desc Secondary-rack-Beta \
--site_name Site-Tango \
--rack_name Rack-Beta

Example 2
Modify name of rack with rack “id 53a354f3-9af8-410e-88d0-3332f3c15191” to
“Rack-Gamma”:
# hyperscale rack-update 53a354f3-9af8-410e-88d0-3332f3c15191 \
--rack_name Rack-Gamma

Example 3
Modify the description of rack with rack “id 53a354f3-9af8-410e-88d0-3332f3c15191”
to “Standby rack: Gamma”:
# hyperscale rack-update 53a354f3-9af8-410e-88d0-3332f3c15191 \
--desc "Standby rack: Gamma"

Associate a compute node with a rack
Run the following command on the HyperScale Controller node:
# hyperscale node-tag-rack <computenodenameorIP> <rack_id>

Associating a compute node with a rack, also referred to as tagging, is required for
rack resiliency to take effect. You can perform this task only after you add the rack
information to the configuration.
To view inline help about the command, type the following:
# hyperscale help node-tag-rack

Example 1
Tag node “Alpha-compute1.veritas.com” with rack with rack id
“53a354f3-9af8-410e-88d0-3332f3c15191”:
# hyperscale node-tag-rack Alpha-compute1.veritas.com \
53a354f3-9af8-410e-88d0-3332f3c15191

Example 2
Tag node “77.206.105.132” with rack with rack id
“53a354f3-9af8-410e-88d0-3332f3c15191”:
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# hyperscale node-tag-rack 77.206.105.132 \
53a354f3-9af8-410e-88d0-3332f3c15191

View list of racks and their rack IDs
Run the following command on the HyperScale Controller node:
# hyperscale rack-list

The output displays information similar to the following:
+--------------------------+-----------+-------------+---------------+
| rack_id
| rack_name | site_name
| description
|
+--------------------------+-----------+-------------+---------------+
| 1510-3fb5-47b5-ba7f-41ab | Rack-Beta | Site-Tango | Secondary-Beta|
| 3b6c-bb16-4050-ade8-e935 | Rack-Gamma| Site-Tango | None
|
| 5335-9af8-410e-88d0-3332 | Rack-Alpha| Site-Charlie| Primary-Alpha |
+--------------------------+-----------+-------------+---------------+

You can also run the following command to see the list of compute nodes and the
assigned rack details:
# hyperscale nodes

The output displays a lot more information about the systems in your HyperScale
configuration. This includes the host ID, host name, data IP address, network IP
address, node personality type, status, hypervisor ID, version and rack ID.

View rack resiliency status for an instance
After you tag the compute nodes with their respective racks, all instances that are
launched thereafter display the rack resiliency status as part of their metadata
information. Use the HyperScale dashboard to view the rack resiliency status for
an instance.
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To view the rack resiliency status for an instance

1

Log on to the HyperScale dashboard using OpenStack admin user credentials.
Use the following URL:
https://<controllerIPaddress>/horizon/auth/login

2

Navigate to Project > Instances.
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3

From the Instances table, under the Instance Name column, click on an instance
name to view its information.

4

On the Overview tab, scroll to the Metadata section.
The rack_resiliency field value indicates the status of rack resiliency for the
instance.
Rack resiliency
status

Description

Not applicable

For instances associated with Gold or Silver flavors, this status
indicates that one or more compute nodes in the configuration
are not tagged with any rack information.
Even if the instance itself is running on a tagged compute, the
fact that at least one compute node is not tagged results in this
status. The configuration is therefore not treated as rack
resilient.

Note: Instances associated with bronze flavor display this
status as there is no reflection factor for bronze instances.
Healthy

Indicates that the configuration is rack resilient.

Degraded

A degraded status indicates that eligible compute nodes are
not available on the alternate rack. The reflection target for the
computes are therefore created on available computes on the
same rack where the source compute node is located.
Even though the configuration is treated as rack resilient, the
reflection targets are created on the source rack due to a lack
of compute nodes on another rack.

Multi-rack command logs
When you run HyperScale commands to configure and administer a multi-rack
HyperScale configuration, the command output confirms whether or not the
command was successful.
For example, when you run the following command to add a rack:
# hyperscale rack-add Rack-Alpha

The output confirms that the command was successful:
+----------+--------------------------------------+
| Property | Value
|
+----------+--------------------------------------+
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| response | Rack - Rack-Alpha added successfully |
+----------+--------------------------------------+

However, if a command fails for some reason, the output confirms the failure and
also displays the reason for the failure.
For example, when you run the following command to remove a rack:
# hyperscale rack-remove c02-c3d2-42-8c54-d7b

The output confirms why the command failed:
+----------+-----------------------------------------------------+
| Property | Value
|
+----------+-----------------------------------------------------+
| response | No rack id - c02-c3d2-42-8c54-d7b found in database |
+----------+-----------------------------------------------------+

In some cases, the command output displays an HTTP 500 error that resembles
the following:
ERROR: The server has either erred or is incapable of performing the
requested operation. (HTTP 500)
(Request-ID: req-bb7f5104-abcd-efgh-34hijk33lmno)

All multi-rack command logs are maintained in the HyperScale api log file at the
following location:
/var/opt/VRTSofmn/logs/hyperscale-api.log

You can also refer to the following log file to get more details:
/var/opt/VRTSofcore/logs/controller.log
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Performing a live migration
This chapter includes the following topics:
■

Configuring OpenStack to support HyperScale live migration

■

Enabling live migration

■

Performing a live migration

Configuring OpenStack to support HyperScale
live migration
To perform live migrations in HyperScale, you must make the following changes to
the OpenStack configuration.
Table 7-1

OpenStack configuration changes to support HyperScale live
migration

For this item ...

Make this change ...

nova.conf

rpc_response_timeout = 180
(The default is 60.)

cinder.conf

rpc_response_timeout = 180
(The default is 60.)

MySQL

Max Connections = 2048

Performing a live migration
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Table 7-1

For this item ...

OpenStack configuration changes to support HyperScale live
migration (continued)
Make this change ...

RabbitMQ configuration Add the following lines:
file
[binary,
{packet, raw}
,
{reuseaddr, true}
,
{backlog, 128}
,
{nodelay, true}
,{linger,{true,0}},
{exit_on_close, false}
,
{sndbuf,32768}
,
{recbuf,32768}
,
{keepalive, true}
]}

Note: If SELinux is enabled, you need to perform certain additional steps for
OpenStack live migration to work. Refer to the OpenStack documentation for more
information.

Enabling live migration
If you have deployed OpenStack in a Juju-based environment using Juju controller
or Metal as a Service (MAAS) server, then live migration may not be enabled by
default.
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Enable live migration manually by running the following commands on the Juju
controller:
# juju config nova-compute enable-live-migration=true
# juju config nova-compute migration-auth-type=ssh

Performing a live migration
A live migration moves an instance from one host to another without any interruption
of service. Currently, you can only live migrate one instance at a time, and
HyperScale determines the host the instance is migrated to.
To perform a live migration

1

Navigate to Admin > System > Instances.

2

In the table on the Instances page, locate the host that is running the instance
you want to live migrate. This example uses host sdsr720-09 and migrates
instance VM1.
Use the Actions drop-down list to select Live Migrate Instance.

3

Live Migrate dialog box shows the Current Host for the virtual machine.
Click Submit.

4

HyperScale updates the Instances page Status column as the migration
occurs. Note that the instance is on a different host, sdsr720-02.
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Troubleshooting
This chapter includes the following topics:
■

HyperScale alerts reference

■

About HyperScale log files

■

Synchronizing data node reflection after a failure

■

Handling a data node failure due to a disk fault

■

Recovering a compute node after a storage media failure

■

Handling controller node reboot failures

■

HyperScale nodes status shows as up even if one or more OpenStack services
are down

■

Launching an instance from a new project may fail

■

HyperScale and Ceph co-existence issues

■

Instance gets launched with two IP addresses

■

Grafana user interface may fail to launch

■

HyperScale commands may fail due to an authentication failure

■

Backup operations may fail after a data node reboot

HyperScale alerts reference
The Alerts area of the HyperScale dashboard displays information or errors that
you may need to take action on. This section list each HyperScale alert and its
accompanying text. Variable strings being with a percent sign are replaced with the
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text relevant to your situation, such as the name of a compute node or a storage
device.
Table 8-1
Alert name

Text

alert.cloud.cache.ssdthres

SSD usage on %(ASSOC)s high

alert.cloud.cache.ssdthresl2

SSD usage on %(ASSOC)s reached 70 percent

alert.cloud.compute.down

Compute %(ASSOC)s service is down

alert.cloud.dal.ioerror

I/O error on compute %(ASSOC)s

alert.cloud.disk.removed

Disk from Compute %(ASSOC)s is removed. Please
live migrate any existing instances from this Compute
and perform Disable and Enable operations to re-use
this compute

alert.cloud.dn.down

Datanode %(ASSOC)s service is down

alert.cloud.dnsl.ioerror

I/O error on datanode %(ASSOC)s

alert.cloud.eds.failed

Snapshot creation failed for compute %(ASSOC)s due
to network connection failure

alert.cloud.hdd.failed

I/O error occurred on vdisk associated with compute
%(ASSOC)s. Use vxdisk list command to know the failed
HDDs

alert.cloud.poolutil.exceeded

%(ASSOC)s is using more than 90 percent of its storage

alert.cloud.qos.miniops

Cannot serve miniops for compute %(ASSOC)s

alert.cloud.ssd.failed

SSD I/O error on %(ASSOC)s. Use vxdisk list command
to know the failed SSDs

alert.cloud.vm.failed

VM has failed on compute %(ASSOC)s due to storage
daemon restart

alert.compute.cache.ssdthres

SSD usage on %(SOURCE)s high

alert.compute.cache.ssdthresl2

SSD usage on %(SOURCE)s reached 70 percent

alert.compute.dal.ioerror

I/O error on VM %(ASSOC)s in compute %(SOURCE)s

alert.compute.disk.removed

Disk %(ASSOC)s from Compute %(SOURCE)s is
removed. Please live migrate any existing instances
from this Compute and perform Disable and Enable
operations to re-use this compute
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Table 8-1

(continued)

Alert name

Text

alert.compute.eds.failed

Snapshot creation failed for VM %(ASSOC)s in compute
%(SOURCE)s due to network connection failure

alert.compute.hdd.failed

I/O error occurred on vdisk associated with compute
%(SOURCE)s. Use vxdisk list command to know the
failed HDDs

alert.compute.qos.miniops

Cannot serve miniops for VM %(ASSOC)s in compute
%(SOURCE)s

alert.compute.service.down

Compute %(SOURCE)s service is down

alert.compute.snapshot.failed

Episodic snapshot creation failed for tenant
%(TENANT)s and compute %(SOURCE)s for Instance
%(ASSOC)s. Please ensure that there are no quota
restrictions for creating snapshots

alert.compute.ssd.failed

SSD I/O error on %(SOURCE)s. Use vxdisk list
command to know the failed SSDs

alert.compute.vm.failed

VM has failed on compute %(ASSOC)s due to storage
daemon restart

alert.dn.dnsl.ioerror

I/O error on datanode %(SOURCE)s

alert.dn.poolutil.exceeded

%(SOURCE)s is using more than 90 percent of its
storage

alert.dn.service.down

Datanode %(SOURCE)s service is down

alert.vdisk.bst.failed

BST hydrate workflow failed for vdisk %(SOURCE)s

alert.vdisk.dal.ioerror

I/O error on vdisk %(SOURCE)s

alert.vdisk.dnrs.failed

Datanode reflection failure for vdisk %(ASSOC)s

alert.vdisk.dnrt.failed

Datanode reflection failure for vdisk %(ASSOC)s

alert.vdisk.eds.failed

Snapshot creation failed for vdisk %(SOURCE)s due to
network connection failure

alert.vdisk.qos.miniops

Cannot serve miniops for vdisk %(SOURCE)s

alert.vdisk.ror.failed

RoR workflow failed for vdisk %(SOURCE)s

alert.vdisk.smf.failed

SMF workflow failed for vdisk %(SOURCE)s
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Table 8-1

(continued)

Alert name

Text

alert.vdisk.snapshot.failed

Episodic snapshot creation failed for tenant
%(TENANT)s and vdisk %(SOURCE)s. Please ensure
that there are no quota restrictions for creating
snapshots

alert.vdisk.ssf.failed

SSF workflow failed for vdisk %(SOURCE)s

alert.vm.bst.failed

BST hydrate workflow failed for vdisk %(ASSOC)s
associated with instance %(SOURCE)s

alert.vm.cnrt.failed

Storage Redundancy SLA is violated for an Instance
"%(SOURCE)s". Refer to hyperscale cli option to get
the current status of storage redundancy level

alert.vm.dal.ioerror

I/O error on vdisk %(ASSOC)s in VM %(SOURCE)s

alert.vm.degraded.dn.sla

VM %(SOURCE)s is not able to meet resiliency SLAs
for snapshots due to datanode failure

alert.vm.dnror.failed

Failed to restore Datanode resiliency for vdisk
%(ASSOC)s

alert.vm.dnrt.failed

Datanode reflection failure for vdisk %(ASSOC)s in VM
%(SOURCE)s

alert.vdisk.eds.failed

Snapshot creation failed for vdisk %(SOURCE)s due to
network connection failure

alert.vm.failed

VM %(SOURCE)s has failed due to storage daemon
restart

alert.vm.qos.miniops

Cannot serve miniops for vdisk %(ASSOC)s in VM
%(SOURCE)s

alert.vm.ror.failed

RoR workflow failed for vdisk %(ASSOC)s associated
with instance %(SOURCE)s

alert.vm.smf.failed

SMF workflow failed for vdisk %(ASSOC)s associated
with instance %(SOURCE)s

alert.vm.snapshot.failed

Episodic snapshot creation failed for tenant
%(TENANT)s and Instance %(SOURCE)s for vdisk
%(ASSOC)s. Please ensure that there are no quota
restrictions for creating snapshots

alert.vm.ssf.failed

SSF workflow failed for vdisk %(ASSOC)s associated
with instance %(SOURCE)s
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About HyperScale log files
HyperScale includes one or more log files for the following components.
Table 8-2

Controller logs

Log file

Contents

/var/opt/VRTSofcore/logs/ofengine.log

Installation information.

/var/opt/VRTSofcore/logs/<datanode_mgmtIP>_config.log Information about add and
remove operations performed on
a data node.
/var/opt/VRTSofcore/logs/<computenode_mgmtIP>_config.log Information about enable and
disable HyperScale operations
performed on a compute node.
/var/opt/VRTSofcore/logs/controller.log

Information about all HyperScale
tasks.

/var/opt/VRTSofcore/logs/default.log

Statistics logs.

/var/opt/VRTSofmn/logs/zookeeper.log

Zookeeper service logs.

Table 8-3

Compute node logs

Log file

Contents

var/opt/VRTSofcore/logs/hypervisor.log

HyperScale MQ service logs on
the compute node.

var/log/hypervisor.log

Compute storage service logs.

Table 8-4

Data node logs

Log file

Contents

/var/opt/VRTSofcore/logs/dnhypervisor.log HyperScale MQ service logs on
the data node.
/var/log/HyperScale.log

Data node storage service logs.

/var/log/ofbud.log

Information used to
troubleshooting the HyperScale
bud service.
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Table 8-5

External storage provider and NetBackup logs

Log file

Contents

/var/opt/VRTSofesp/logs/hyperscale-esp.log Logs each export or import
operation initiation request.
/var/opt/VRTSofesp/logs/Export_ID/export.log Detailed information on export
job Export_ID.
/var/opt/VRTSofesp/logs/Import_ID/export.log Detailed information on import
job Import_ID.
media server FQDN_esp_add.log

Logs the progress of registering
the NetBackup Media Server with
HyperScale.

Synchronizing data node reflection after a failure
A HyperScale data node ensures resiliency by writing its data to another (secondary)
data node. This process is called reflection. HyperScale supports up to two data
nodes.
For a virtual disk (vDisk) that has the Silver flavor or above, data is reflected from
primary data node to secondary data node. In this configuration, if one of the data
nodes fail, the reflection breaks, and the vDisk goes into a resiliency degraded
state. All the requests are now served from a single data node, and there is only
one copy of the data.
This issue can occur in the following situations:
■

The vDisk's primary data node fails.

■

The secondary data node fails.

To resolve this issue, you must add a new data node in place of the one that failed.
Then, restore reflection by synchronizing the new data node with the active data
node. The information on the new data node is brought up to date.
To synchronize data node reflection

1

2

Remove the data node that failed and do one of the following:
■

Add a new data node with a different IP address.

■

Recover the failed data node and add it back with a different IP address.

Start data node synchronization. On the primary data node, enter the following
command:
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hypercale restore-dn-refl new_data_node_public_ip_address

This command does the following:
■

It recovers any existing snapshots from all the degraded vDisks to the new
data node.

■

It restores resiliency to the new data node for all the vDisks that are in a
degrade state.

When the synchronization finishes, the degraded states of all the degraded
vDisks are cleared. The reflection of the Disk's is enabled, and the newly added
data node serves as the secondary data node.

Handling a data node failure due to a disk fault
In the case of a storage failure, the data node goes into the down state. The
secondary data node serves the snapshot or episodic data synchronization read
or write request. To bring up the failed data node again, use the following procedure.
To handle a data node failure due to a disk fault

1

Remove the data node.
See “Removing a data node” on page 26.

2

Remove or replace the failed disk, depending on the storage failure you
encounter.

3

Add the data node again. You can specify a new disk or the same disk as
before.
See “Adding a data node” on page 21.
This operation deletes all the data on the remaining disks, and a new data
node starts.

Recovering a compute node after a storage media
failure
In case of solid-state drive (SSD) or hard disk drive (HDD) storage media failure
(SMF) on a compute node, HyperScale provides storage resiliency for the instances
running on that compute. The applications running on the instances do not
experience any timeout or errors.
The following sequence of events describes how HyperScale provides storage
resiliency in such a scenario:
■

HyperScale detects a storage issue when instance I/Os begin to fail.
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■

The Controller detects these failures and immediately redirects the instance I/O
requests to the designated reflection targets.
The compute node that served as the reflection target now becomes the new
source for the instances.

■

The Controller initiates the restoration of reflection (ROR) workflow to restore
the reflection factor. The Controller selects alternate compute nodes as new
reflection targets for the instances. The reflection targets reside on a single
compute node or across multiple alternate computes, depending on the available
compute nodes and workload distribution in the configuration.

■

The original compute node where the instances were running is not considered
as a potential reflection target because of the storage media failure. The compute
node is alive and running but is not capable of providing full storage resiliency
to instances that are running on it. It is therefore considered to be in a "degraded"
state.
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Depending on the type of media failure, one or more of the following alerts are
displayed in Horizon (HyperScale > Overview > Alerts/Events):
SSD I/O error on <computenodename>.
Use vxdisk list command to know the failed SSDs.
I/O error occurred on vdisk associated with compute <computenodename>.
Use vxdisk list command to know the failed HDDs.

Similar failure messages may also appear in the Controller log file.
Perform the following steps to recover the compute node from a media failure:
1.

Perform a live migration of the instances from the affected compute node to
an alternate active compute node where HyperScale is enabled.
See “Performing a live migration” on page 94.

2.

Remove the affected compute node from the HyperScale configuration.
See “Disabling HyperScale on a compute node” on page 31.

3.

Resolve the storage media failure issue.

4.

Add the compute node that you removed earlier in step 2, back in to the
HyperScale configuration.
See “Enabling HyperScale on a compute node” on page 27.
The compute is ready to host instances after you enable HyperScale on it. All
the relevant storage media failure alerts are automatically cleared from the
Horizon user interface.
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Handling controller node reboot failures
Controller reboot is not fully supported in this release. If the controller node is
restarted, the controller may go in to an unpredictable state.
The HyperScale services may not start in the correct order and the HyperScale
storage driver may fail to register with the Cinder service. As a result, instance
creation may fail due to storage errors.
Use the get-workflows-in-progress API to determine whether or not the
controller node is ready for a reboot
Run the following command on the controller node and observe the command
output:
# hyperscale get-workflows-in-progress

If the command output is TRUE, it indicates that there is at least one workflow in
progress and the controller should not be restarted.
If the command output is FALSE, it indicates that there is no active workflow in the
pending state and the controller can safely be restarted.

HyperScale nodes status shows as up even if one
or more OpenStack services are down
HyperScale does not immediately detect if any of the OpenStack services, such as
the compute service (nova compute) or the block storage service (cinder-volume),
are down. The HyperScale nodes status shows as up in both the user interface and
the command line (hyperscale nodes). The status of the nodes does not change
even in case any of the dependent services are down.
While this does not block any configuration tasks, there may be failures eventually
during the actual execution of operations such as live migration or storage and
image management tasks.
Workaround:
HyperScale services are dependent on the OpenStack services. If any of the
operations fail but the HyperScale services are running, as a general guideline, the
first step for troubleshooting such issues is to verify that all the OpenStack services
are up and running.
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Launching an instance from a new project may
fail
After deploying HyperScale in a distributed OpenStack environment, if you create
a project (tenant) and then try to launch an instance using a user from that tenant,
the instance may fail to launch.
Messages similar to the following may appear in the controller log file located at
/var/opt/VRTSofcore/logs/controller.log:
ERROR - Cinder client authentication failure The request you have made
requires authentication.(HTTP 401)
ERROR - Exception while getting volume: The resource could not be
found.(HTTP 404)
ERROR - Failed for external function call
hyperscale.controller.connect.compute.volume
ERROR - Failed for external function call with exception
'volume' referenced before assignment

local variable

Workaround:
Add the _proxy_ user as a member of the new project that you created and then
try to launch the instances.
To add the _proxy_ user to a project

1

Launch a web browser and type the URL for the OpenStack Horizon dashboard.
The URL format is as follows:
http://<ControllerNameorIP>/horizon/

Here, <ControllerNameorIP> is the fully qualified domain name or public IP
address of the controller node.

2

Specify the OpenStack admin user name and password on the login page and
click Connect.

3

Navigate to Identity > Projects and then in the Projects pane click Manage
Members.

4

In the Edit Project dialog box, perform the following steps on the Project
Members tab:
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5

■

From under the All Users box on the left, click the plus sign against the
_proxy_ user to add that user to the Project members list that appears
on the right.

■

Ensure that the _proxy_ user has at least the Admin privilege assigned.

■

Click Save.

You can now try to launch the instances from the project where you added the
_proxy_ user.

HyperScale and Ceph co-existence issues
The following issues may occur if HyperScale and Ceph are deployed in the same
OpenStack configuration.

HyperScale volumes remain in the creating state
When you try to create volumes of type Veritas_HyperScale, the volume remains
in the creating state and the operation does not complete.
Workaround:
Update the cinder.conf file on the cinder scheduler node as follows:
1.

Edit the cinder.conf configuration file and add the following entry under the
DEFAULT section:
control_exchange = cinder

2.

Restart the following services on the cinder scheduler node:
■

cinder-scheduler
# systemctl restart cinder-scheduler.service

■

cinder-volume
# systemctl restart cinder-volume.service

■

Apache 2 Web Server
# systemctl restart apache2.service

3.

Re-create the volumes that appeared in the creating state.

Ceph instances get scheduled on HyperScale computes
and may fail to launch
If you launch instances of type Ceph, they may get scheduled on HyperScale
compute nodes and may eventually fail to launch. If the number of HyperScale
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compute nodes are more than the Ceph nodes, the instance launch operation is
attempted three times before it fails permanently.
Workaround:
Create host aggregates for all the Ceph compute nodes.
Perform the following steps:
1.

Modify the OpenStack instance Flavors in the configuration
Add the following key-value pair to the flavor metadata:
■

Key: ceph

■

Value: True

For example, the following command adds this key-value pair to a flavor named
MyTestFlavor:
# openstack flavor set MyTestFlavor --property ceph=True

2.

Create a Host aggregate group for Ceph hosts.
# openstack aggregate create ceph
# openstack aggregate set ceph --property ceph=True

3.

All all the Ceph compute nodes to the host aggregate you created earlier.
# openstack aggregate add host ceph <Ceph compute node name>

Instance gets launched with two IP addresses
When you launch an instance it sometimes get assigned with two IP addresses
simultaneously. As a result, even though the instance is live and running, you may
not be able to establish an SSH connection with it.
Workaround:
This is a known OpenStack issue. Perform the following steps to resolve it.
1.

Edit the nova.conf configuration file and comment out the following entries:
#dhcpbridge_flagfile=/etc/nova/nova.conf
#dhcpbridge=/usr/bin/nova-dhcpbridge

2.

Restart the nova-compute service.
# systemctl restart nova-compute.service
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Grafana user interface may fail to launch
The Grafana user interface (UI) configuration process may sometimes fail while
deploying HyperScale charms. This typically occurs if the Grafana Server service
restart does not complete successfully. In such a case, you cannot launch the
Grafana UI from the OpenStack Horizon dashboard.
Workaround:
Perform the following steps on the HyperScale controller unit:
1.

Start the grafana-server service, if it is not already running:
# sudo systemctl start grafana-server

2.

Configure the grafana-server service to start automatically on a system
reboot:
# sudo systemctl enable grafana-server

3.

Verify that the grafana-server service is running:
# sudo systemctl status grafana-server

The command output should resemble the following:
grafana-server.service - Grafana instance
Loaded: loaded (/usr/lib/systemd/system/grafana-server.service;
enabled; vendor preset: enabled)
Active: active (running)

4.

Run the HyperScale grafanaAPI.py configuration script to reconfigure the
Grafana UI:
# python /opt/VRTSofcore/adm/grafanaAPI.py

The script adds a data source for Grafana and also creates a user named
hyperscale with password as hyperscale.
5.

Restart the grafana-server service for the changes to take effect:
# sudo systemctl restart grafana-server

6.

You can now launch the Grafana UI from the OpenStack Horizon dashboard.
See “Accessing the HyperScale Grafana UI” on page 16.
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HyperScale commands may fail due to an
authentication failure
HyperScale commands may sometimes fail with a password authentication failure
message. To ensure that the HyperScale commands work without any issues, you
may need to modify the project-specific OpenStack environment file (OpenStack
rc file).
Here's a sample of the authentication information that should be added to the rc
file:
export OS_USERNAME=[adminusername]
export OS_PASSWORD=[adminuserpassword]
export OS_AUTH_URL=[http://[keystone IP]:5000/v3]
export PS1='[\u@\h\W(keystone_admin)]\$'
export OS_PROJECT_NAME=[adminprojectname]
export OS_USER_DOMAIN_NAME=Default
export OS_PROJECT_DOMAIN_NAME=Default
export OS_IDENTITY_API_VERSION=3

After adding this information you need to source the rc file. It ensures that the
environment variables are set for the shell from where you run the HyperScale
commands.

Backup operations may fail after a data node
reboot
When a data node is restarted, the HyperScale vDisks and their snapshots are not
immediately available on the node. This issue occurs due to a filesystem mount
failure on the data node. As a result, the backup operations that use those snapshots
begin to fail.
Workaround:
Perform the following steps on the data node where the issue occurs:
1.

Stop the Network File System (NFS) server.
# sudo systemctl stop nfs-kernel-server

2.

Unmount the filesystem that hosts the HyperScale snapshots.
# fusermount -u /export/verfs
# fusermount -u /verfs
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3.

Start the HyperScale process (hsverfs) that creates the filesystem that hosts
the snapshots.
# /opt/VRTSofdn/bin/hsverfs /verfs

4.

Create a bind mount for the snapshot filesystem.
# mount --bind /verfs /export/verfs

5.

Start the NFS server.
# sudo systemctl start nfs-kernel-server

6.

Export the filesystem.
# exportfs -rv
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Command reference
This chapter includes the following topics:
■

Vendor registration commands

■

Regular expression (regex) policy commands

■

Instance snapshot and restore from snapshot commands

■

Export and import commands

■

Backup and restore commands

Vendor registration commands
This section describes commands for registering an external storage provider or
backup vendor with HyperScale and displaying information about the vendor.

vendor-add
Installs the Veritas HyperScale external storage provider on the external node.
Usage
hyperscale vendor-add <servername> <pwd> <openstackpwd> <vendor_type>
<export_path>

Arguments

Command reference
Vendor registration commands

Positional argument

Description

<servername>

The vendor server name/fully qualified domain name.
If the vendor type is NetBackup, specify the NetBackup Media
Server name/fully qualified domain name.
If the vendor type is HyperScaleESP, specify the storage
server/fully qualified domain name.

<pwd>

Vendor server's root user password.

<openstackpwd>

The OpenStack password.

<vendor_type>

A supported vendor type. Either NetBackup or
HyperScaleESP.

<export_path>

The path on the HyperScale external storage provider where
exported snapshots will be stored.

vendor-by-id
Gets vendor information from the ID registered with HyperScale.
Usage
hyperscale vendor-by-id <vendorid>

Positional argument

Description

<vendorid>

The vendor ID.

vendor-clear
Clears vendor details.
Usage
hyperscale vendor-clear <register_id>

Positional argument

Description

<register_id>

You must provide the register ID.

vendor-list
Lists all vendors registered with HyperScale.
Usage
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hyperscale vendor-list [--status <status>]

Optional argument

Description

--status <status>

The vendor register status.

vendor-remove
Uninstalls the Veritas HyperScale external storage provider from the external node.
Usage:
hyperscale vendor-remove <servername> <pwd> <openstackpwd> <register_id>

Positional argument

Description

<servername>

The vendor server name/fully qualified domain name.
If the vendor type is NetBackup, specify the NetBackup Media
Server name/fully qualified domain name.
If the vendor type is HyperScaleESP, specify the storage
server/fully qualified domain name.

<pwd>

Vendor server's root user password.

<openstackpwd>

The OpenStack password.

<register_id>

The registration ID.

Regular expression (regex) policy commands
This section describes the commands used to work with backup policies.

backup-images-by-policy
List available backup images for a NetBackup backup policy.
Usage
hyperscale backup-images-by-policy [--mode <mode>]
[--fetch_all_images <fetch_all_images>]
<policy_name>

Positional argument

Description

<policy_name>

The NetBackup backup policy name.
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Optional argument

Description

--mode <mode>

To be set to <simulator> if you are working with the
NetBackup simulator. Default=<real>.

--fetch_all_images
<fetch_all_images>

Fetch all backup images; that is, backup images belonging
to instances of different HyperScale installations.
Default=False.

backup-policy-list
Get the list of HyperScale policies available from the backup vendor registered with
this HyperScale installation.
Usage
hyperscale backup-policy-list [--mode <mode>] function

Optional argument
--mode <mode>

To be set to <simulator> if you are working with NetBackup
simulator. Default=<real>.

policy-regex-clear-all
Clear all policy regular expressions.
Usage
hyperscale policy-regex-clear-all

policy-regex-create
Assign policy regex.
Usage
hyperscale policy-regex-create <name> <query>

Positional argument

Description

<name>

Policy name.

<query>

Policy query; for example, "{'name':'name contains by VM',
'status':'active'}".

113

Command reference
Regular expression (regex) policy commands

policy-regex-get
Get policy regular expression.
Usage
hyperscale policy-regex-get <name>

Positional argument

Description

<name>

Policy name.

policy-regex-get-result
Get the policy regex result ad list of virtual machines
Usage
hyperscale policy-regex-get-result <name>

Positional argument

Description

<name>

Policy name.

policy-regex-remove
Remove a policy regex.
Usage
hyperscale policy-regex-remove <name>

Positional argument

Description

<name>

Policy name.

policy-regex-update
Update a policy regex.
Usage
hyperscale policy-regex-update <name> <query> <status>

Positional argument

Description

<name>

Policy name.
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Positional argument

Description

<query>

Policy query; for example, "{'name':'name contains by VM',
'status':'active'}".

<status>

Policy status; for example, assigned or unassigned.

Instance snapshot and restore from snapshot
commands
This section describes commands for creating instance snapshots and restoring
them.

instancesnapshot-create
Initiate an instance-level user snapshot. It contains snapshot(s) of vDisks and
instance metadata.
Usage
hyperscale instancesnapshot-create <Instance ID> <Snapshot Name>

Argument

Description

<Instance ID>

The instance ID of the instance for which snapshot is to be
created.

<Snapshot Name>

The name to give the snapshot.

instancesnapshot-list
List user-created snapshots.
Usage
hyperscale instancesnapshot-list [--all-tenants [<0|1>]]
[--instance-id <instance-id>]
[--snapshot-type <snapshot-type>]

Optional argument

Description

--all-tenants [<0|1>]

Shows details for all tenants. Only the HyperScale
infrastructure administrator can specify this option.

--instance-id <instance-id>

Filters list by a instance ID. Default=None.
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Optional argument

Description

--snapshot-type
<snapshot-type>

Filters list by snapshot type <User|Bkup|All>. Default=User.

instancesnapshot-restore
Initiate the user snapshot restore operation.
Usage
hyperscale instancesnapshot-restore <InstanceSnapId> <NewVmName>

Positional argument

Description

<InstanceSnapId>

The instance snapshot ID.

<NewVmName>

The name to be given to the new instance.

instancesnapshot-delete
Delete a user snapshot.
Usage
hyperscale instancesnapshot-delete <InstanceSnapId>

Argument

Description

<InstanceSnapId>

The instance snapshot ID.

instancesnapshot-query
Query the status of a user-initiated snapshot.
Usage
hyperscale instancesnapshot-query <InstanceSnapId>

Argument

Description

<InstanceSnapId>

The instance snapshot ID.

Export and import commands
This section describes commands for exporting and importing snapshots.
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instancesnapshot-create-n-export
Take a new instance snapshot and initiate its export.
Usage
hyperscale instancesnapshot-create-n-export <Instance ID> <SnapshotName>

Argument

Description

<Instance ID>

The instance ID of the instance for which snapshot is to be
created and exported to the registered external storage.

<Snapshot Name>

The name to give the snapshot to be exported.

instancesnapshot-export-a-copy
Exports a copy of an existing instance snapshot to the registered external storage
provider.
Usage:
hyperscale instancesnapshot-export-a-copy <Snapshot ID>

Argument

Description

<Snapshot ID>

The snapshot ID of the instance snapshot.

instancesnapshot-export-image-delete
Delete the exported image of a snapshot from the HyperScale external storage
provider.
Warning: Exercise caution. You cannot reverse this action.
Usage
hyperscale instancesnapshot-export-image-delete <objectid> <ExportId>

Argument

Description

<objectid>

The instance's HyperScale ID.

<ExportId>

The export ID.
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instancesnapshot-export-images-by-object-list
List the exported images for an instance.
Usage
hyperscale instancesnapshot-export-images-by-object-list <objectid>

Argument

Description

<objectid>

The instance's HyperScale ID.

instancesnapshot-export-images-list
List all the exported images.
Usage
hyperscale instancesnapshot-export-images-list
[--fetch_all_images <fetch_all_images>]

Argument

Description

--fetch_all_images
<fetch_all_images>

Lists all the exported images.

instancesnapshot-export-job-delete
Purge the instance snapshot export job from HyperScale.
Usage
hyperscale instancesnapshot-export-job-delete

Argument

Description

<ExportId>

The export ID.

instancesnapshot-export-job-list
List the instance snapshot export jobs that are in progress, completed, or failed.
Usage
hyperscale instancesnapshot-export-job-list [--all-tenants [<0|1>]]
[--instance-id <instance-id>]
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Argument

Description

--all-tenants [<0|1>]

Shows details for all tenants. Only the HyperScale
infrastructure administrator can use this argument.

--instance-id <instance-id>

Filters the list by an instance ID. Default=None.

instancesnapshot-export-job-query
Query the status of a snapshot export job.
Usage
hyperscale instancesnapshot-export-job-query <ExportId>

Argument

Description

<ExportId>

The export ID.

instancesnapshot-import
Launch a new instance (also known as an import) from an exported snapshot.
Usage
hyperscale instancesnapshot-import [--hyperscale_id <hyperscale_id>]
[--target_tenant_id <target_tenant_id>]
[--network-id <network_id>]
<export_id> <new_instance_name>
<exp_jobid> <instance_id>
<src_tenant_id>

Positional arguments

Description

<export_id>

The export ID.

<new_instance_name>

The name of the new instance.

<exp_jobid>

The export job ID.

<instance_id>

The VM ID of the backed up instance.

<src_tenant_id>

The instance's tenant ID at the time of export.

Optional argument

Description

--hyperscale_id <hyperscale_id>

The HyperScale installation ID at the time of export.
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Optional argument

Description

--target_tenant_id <target_tenant_id>

The target project or tenant ID. The default is
src_tenant_id. However, it must be provided if the
source tenant does not exist.

--network-id <network_id>

The network ID. You must specify this argument
if the current network configuration is different than
the backup network configuration.
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instancesnapshot-import-job-delete
Purge the import job/task from HyperScale.
Usage
hyperscale instancesnapshot-import-job-delete <restoreid>

Positional argument

Description

<restoreid>

The restore ID.

instancesnapshot-import-job-list
List the import jobs that are in progress, completed, or failed for an instance.
Usage
hyperscale instancesnapshot-import-job-list [--instance-id <instance_id>]

Optional argument

Description

--instance-id <instance_id>

Filters list by an instance ID. Default=None.

instancesnapshot-import-job-query
Query the status of an import job.
Usage
hyperscale instancesnapshot-import-job-query <import_id>

Positional argument

Description

<import_id>

The import ID.

Command reference
Backup and restore commands

Backup and restore commands
This section describes commands for backing up and restoring resources.

backup-count
Get the number of backups for a given resource.
Usage
hyperscale backup-count <resource_id> <resource_type>

Positional argument

Description

<resource_id> resource id <instance_id The resource ID.
| compute_id | datanode_id>
<resource_type> resource type <vm |
compute | datanode>

The resource type.

backup-images-by-object
List the available backup images for an instance.
Usage
hyperscale backup-images-by-object [--mode <mode>] <objectid>

Positional argument

Description

<objectid>

The instance's HyperScale ID.

Optional argument

Description

--mode <mode>

Set to <simulator> if you are working with the NetBackup
simulator. Defult=<real>.

backup-images-by-policy
List the available backup images for a NetBackup backup policy.
Usage
hyperscale backup-images-by-policy [--mode <mode>]
[--fetch_all_images <fetch_all_images>]
<policy_name>
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Positional argument

Description

<policy_name>

NetBackup backup policy name.

Optional argument

Description

--mode <mode>

Set to <simulator> if you are working with NBU simulator.
Defult=<real>.

--fetch_all_images
<fetch_all_images>

Fetch all backup images from all HyperScale installations.
Default=False

backup-job-delete
Purge the backup job/task from the HyperScale task list.
Usage
hyperscale backup-job-delete <backupid>

Positional argument

Description

<backupid>

The backup ID.

backup-job-query
Query the status of a backup job.
Usage
hyperscale backup-job-query <backup_id>

Positional argument

Description

<backup_id>

The backup ID.

backup-jobs-by-object-list
List the backup jobs/tasks in progress, completed, or cancelled for given instance.
Usage
hyperscale backup-jobs-by-object-list <objectid>

Positional argument

Description

<objectid>

The HyperScale object ID of the instance.
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backup-jobs-list
List all the backup jobs/tasks in progress, completed, or cancelled.
Usage
hyperscale backup-jobs-list [--all-tenants [<0|1>]]

Optional argument

Description

--all-tenants [<0|1>]

Displays details for all tenants. Only the HyperScale
infrastructure administrator can specify this argument.

backup-policy-list
Get the list of HyperScale policies available from the backup vendor registered with
this HyperScale installation.
Usage
hyperscale backup-policy-list [--mode <mode>]

Optional argument

Description

--mode <mode>

Set to <simulator> if you are working with the NetBackup
simulator. Default=<real>.

backup-status-show
Get the status of the backup job/task.
Usage
hyperscale backup-status-show <backupid>

Positional argument

Description

<backupid>

Backup ID

get-esp-status
Get the status of the backup node-add operation.
Usage
hyperscale get-esp-status <backup-ip>
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Positional argument

Description

<backup-ip>

The management IP of the backup host added.

restore
Initiate a restore operation from a backup image.
Usage
hyperscale restore [--hyperscale_id <hyperscale_id>]
[--target_tenant_id <target_tenant_id>]
[--network-id <network_id>] [--mode <mode>]
<backupid> <newvmname> <bkp_jobid> <backedup_date>
<backedup_time> <policy> <instance_id>
<src_tenant_id>

Positional argument

Description

<backupid>

The backup ID.

<newvmname>

The new instance name.

<bkp_jobid>

The backup job ID.

<backedup_date>

The backup_date.

<backedup_time>

The backup_time.

<policy>

The backup policy name.

<instance_id>

VM ID of the backed up instance.

<src_tenant_id>

The tenant ID at the time of the backup.

Optional argument

Desceiprion

--hyperscale_id
<hyperscale_id>

The HyperScale installation ID at the time of the backup.

--target_tenant_id
<target_tenant_id>

The target tenant ID. Default: <Same tenancy as when
backed up.> However, it must be provided if the source tenant
does not exist.

--network-id <network_id>

The network ID. It must be specified if the current network
configuration is different than the backup.

--mode <mode>

Set to <simulator> if you are working with NetBackup
simulator. Default=<real>.
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Managing instances
This chapter includes the following topics:
■

Launching an instance from an exported snapshot

■

Attaching a snapshot to a different virtual machine

■

Recovering a data volume to an earlier state

■

Restoring an instance from a backup

Launching an instance from an exported snapshot
You can launch a new instance from an instance snapshot that was previously
exported. This allows you to put an instance into service quickly without specifying
new configuration values. This task can also be performed by the HyperScale
infrastructure administrator.
See “Launching an instance from an exported snapshot” on page 48.

Attaching a snapshot to a different virtual machine
When you attach a snapshot to its parent virtual machine, that process is called
recovery. When you attach the snapshot to the different virtual machine, the process
is called off-hosting storage. To off-host storage, you need the following:
■

A Linux virtual machine and a data volume that is attached to it

■

Data on the volume and storage added

To attach a snapshot to a different virtual machine

1

Navigate to Project > Compute > Volumes.

2

In the Volumes table, click the name of the volume you want to recover.
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3

On the Volume Details page, click the Version List tab. This tab lists the
available snapshots.

4

Select the Version Timeline tab. This tab lists the snapshots for that volume,
beginning with the latest one.

5

Click the name of the snapshot you want to attach.

6

On the Attach Snapshot dialog box, use the VM drop-down list to select the
virtual machine to which the snapshot will be attached. Make sure that this
virtual machine is different from the parent virtual machine.

7

Click Attach.

8

Verify that the snapshot was attached successfully. Navigate to Project >
Compute > Instances.

9

Click the instance name to which you attached the snapshot.

10 Click the Console tab.
11 In the virtual machine console, use a tool like md5sum to verify the integrity of
the data.

Recovering a data volume to an earlier state
If an application fails, you can use HyperScale to recover a data volume from
snapshot to an earlier state.
To perform this task, you need the following:
■

A Linux virtual machine, and a virtual machine that is configured with the Silver
flavor (VTRSSilver) or above.

■

A data volume that is attached to the virtual machine.

■

Data on the data volume (or added storage). By default, a snapshot is created
every 15 minutes. Wait 20 minutes to make sure that the snapshot is created
before you complete the following steps.

To recover a data volume to an earlier state

1

Navigate to Project > Compute > Volumes.

2

In the Volumes table, click the name of the volume you want to recover. (The
virtual machine must have the Silver flavor or above.)

3

On the Volume Details page, click the Version List tab. This tab lists the
available snapshots.

4

Select the Version Timeline tab. This tab lists the snapshots for that volume,
beginning with the latest one.
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5

Click the name of the snapshot you want to attach.

6

On the Attach Snapshot dialog box, use the VM drop-down list to select the
virtual machine to which the snapshot will be attached. Be sure to select the
same parent virtual machine.

7

Click Attach.

8

Verify that the snapshot was attached successfully. Navigate to Project >
Compute > Instances.

9

Click the instance name to which you attached the snapshot.

10 Click the Console tab.
11 In the virtual machine console, use a tool like md5sum to verify the integrity of
the data.

Restoring an instance from a backup
You can restore an instance from a backup. The HyperScale infrastructure
administrator can also perform this task.
See “Restoring an instance from a backup” on page 69.
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Exporting and restoring
virtual machines
This chapter includes the following topics:
■

Monitoring export progress on the user interface

■

Restoring data to a virtual machine

■

Taking and restoring instance snapshots

Monitoring export progress on the user interface
The external storage provider takes instance snapshots and backs up the instance
snapshot once it becomes available. After the export, snapshot is deleted.
If there are multiple instances to be exported, they are snapshotted and exported
one after another. As soon as a snapshot is taken of an instance for export, the
export process for the instance starts.
You can monitor the progress of an export on the instance time line tab (Admin >
Instance > Timeline). When the export process begins, the new export job is
displayed in the export time line in the Creating state. You see a rotating hourglass.
When the export completes, the Creating icon changes to one of the following:
■

Complete (a tick mark icon)

■

Failed (a cross)

The exports remain in the system until they are purged from the external storage
provider.
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Restoring data to a virtual machine
You can restore virtual machine data and other information (including the virtual
machine's flavor and network) from export. You initiate the restore process from
the virtual machine's version time line.
When you click on an export icon, a dialog box is displayed with the Restore to
new option. This option creates a new virtual machine using the data and
configuration that is restored from the export. When you start the restore operation,
new virtual disks are created and the external storage provider restores data in 1
GB chunks on to these newly created vDisks.
To restore data to a new virtual machine

1

Create new vDisks in HyperScale, one for every vDisk present in the export.

2

Restore the data from the export onto the new vDisks

3

Restore configuration information. The configuration consists of the following
parts:

4

■

The virtual machine's flavor information including the amount of RAM, disk
size, virtual CPUs, HyperScale specifications, and so on.

■

The virtual networks that are associated with the virtual machine.

Check if flavor information has changed since an export was performed. Do
one of the following:
■

If the flavor has not changed, use the flavor that is present in the system
to boot the new virtual machine.

■

If the flavor has changed, create a new flavor from the information that is
captured during the export.

5

The network that is associated with the virtual machine when the export was
initiated should be present when the restore in performed. If the same network
is not found, launching the virtual machine fails.

6

Look at the newly created disks and determine which one is the boot disk.

7

Boot the new virtual machine using the boot disk and flavor, and network
information.

8

Attach the other disks that are restored from the export.
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Taking and restoring instance snapshots
When you trigger and instance snapshot, HyperScale executes a snapshot of the
instance's vDisk and captures all the snapshot information and configuration
information.
When you restore an instance from a snapshot, HyperScale creates a new instance
using the information it captures in the instance snapshot metadata. Internally, the
instance snapshot functionality detects if the qemu guest agent is configured for a
virtual machine instance. If it is, HyperScale performs application/filesystem
consistent snapshot of all the vDisks attached to the instance. If the qemu guest
agent is not configured, HyperScale performs a crash consistent snapshot of the
attached vDisks.
To perform an instance snapshot

1

To start the snapshot, do one of the following:
■

On the Project > Compute > Instances page, select Create Snapshot.

■

One the HyperScale command line, enter the following:
# hyperscale-instancesnapshot create

2

On the user interface or command line, enter the instance snapshot name.
HyperScale does the following:
■

If you have configured the qemu guest agent within the instance, HyperScale
performs a guest application/file system consistent snapshot of the vDisk.

■

If qemu quest agent is not configured within the instance, HyperScale
performs a crash consistent snapshot of the vDisk.

■

A snapshot for all the attached vDisk is performed and listed on the Project
> Compute > Volumes > Volume Snapshots tab. The name of volume
snapshot is the same as the instance snapshot name.

■

When all the volume snapshots are marked available, the instance snapshot
is marked as available.

■

The instance snapshot is listed on the instance version time line and on
the Project > Compute > Images page.

■

You can also list the instance snapshot can also be listed using the following
command:
hyperscale-instancesnapshot list
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To restore a virtual machine from an instance snapshot

1

When you trigger a restore of an instance snapshot, HyperScale creates new
volumes from the snapshot volumes.

2

Launch a new instance using the boot disk and configuration within the instance
snapshot metadata.
Note: The network associated with the instance at the time of snapshot should
be present at the time the instance is create. If it is not, the instance fails when
you try to launch it

3

Attach all the data disk to the new instance.
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